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6-9-3 Broken-line Graph
The present values of several consecutive numeral memory table entries are
displayed in the form of a broken-line graph.

0%

Numeral memory
table

30

80

32

72

33

83

Broken-line graph
100%

(1) The values of consecutive memory table entries are converted into percent-
age values, in the range from 0 to 100% or from –100% to 100%, and dis-
played in the form of a broken-line graph.

Operation procedure

Selection using the menu bar: [Objects] → [Graph] 
→ [Broken-line Graph]

Selection using the drawing toolbar:

Terminology

Frame

+Range

–Range

Line

Property setting

General

Position: Indicates the display position of a broken-line graph.
(The reference point is at the upper left corner of the broken-line
graph)

Size: Indicates the size of a broken-line graph.

Frame: Specify whether or not a frame is displayed for a broken-line
graph.

Display Sign: Specify whether or not a display area for negative values is
displayed.

Direction: Specify the display direction (display direction of numeral
memory table entries in ascending order) of a broken-line graph.
Right ( → ), Left ( ← ), Up ( ↑ ), Down ( ↓ )
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Color

Frame: Specify the color of a broken-line graph frame if [Frame] is
selected. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

+Range: Specify the color of broken-line graph displayed for a positive value.
(Can only be set for PTs with color display.) 
White, black, blue, red, magenta, green, cyan, yellow

–Range: Specify the color of broken-line graph displayed for a negative value.
(Can only be set for PTs with color display.) 
Valid only when [Display Sign] is selected.
White, black, blue, red, magenta, green, cyan, yellow

Settings

: Specify this when displaying multiple broken lines. The line
properties [Line] are displayed.

: Specify this when deleting broken lines.

: Specify this when modifying broken lines. The line properties
[Line] are displayed.

Line

Start Table Entry: Specify the start table entry number of the numeral memory
table entries that are displayed in a broken-line graph.

No. of Points: Specify the number of vertices in the broken-line graph.

Interval Type

Even: Specify this when displaying numeral memory table entries at even
intervals.

Uneven: Specify this when displaying numeral memory table entries at
user-selected intervals.

: Set the broken-line intervals if [Uneven] is selected.

Line

Color: Specify the broken-line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Style: Specify the broken-line style.
Solid, Dash, Dot-dash, Dot-dot-dash

100%

Table Entry: Specify this item if a 100% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a 100% value is set with a constant: set the
value to be taken as the 100% value.

0%

Table Entry: Specify this item if a 0% value is set with a numeral memory table
entry: set the table entry number of the numeral memory table.

Value: Specify this item if a 0% value is set with a constant: 
set the value to be taken as the 0% value.
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–100%

Table Entry: Specify this item if a –100% value is set with a numeral memory 
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a –100% value is set with a constant:
set the value to be taken as the –100% value.

Note that specification for –100% is valid only when [Display Sign] is selected.

Guidance

� The following types of broken-line graph element are provided.

0% to 100% display

Direction: Right

Direction: Left

Direction: Up

Direction: Down

� Higher digit word

�Higher digit word

� Higher digit word

�Higher digit word

–100% to 100% display

Direction: Right

Direction: Left

Direction: Up

Direction: Down

� Higher digit word

�Higher digit word

� Higher digit word

�Higher digit word

� Which of [0 to 100%] and [–100 to 100%] broken-line graphs is displayed
should be selected with the setting for [Display Sign] in the general properties.

Check mark set: –100 to 100% display

Check mark not set: 0 to 100% display

� If you specify a broken-line graph element, only one broken line is displayed.
To modify the settings for the broken line, select the broken line to be modified
and click on . The line properties are displayed.
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To add a broken line, click on . A broken line is added and the line
properties are displayed for the added broken line. A maximum of 256 broken
lines can be created.
To delete a broken line, select the broken line to be deleted with the “Settings”
and click on . The specified broken line is deleted.

� The following four types of line are provided for displaying broken-line graphs.

Dot-dot-dashSolid Dash Dot-dash

Set the line type with the [Style] property.

� The relationships between the points (vertices) in a broken-line graph and
numeral memory table contents are shown below.

Numeral memory table

30
70

88
28

When display direction is right

Start table entry number

Number of points

50

67

� The intervals between numeral memory table entries in a broken-line graph
can be set as even or uneven, as desired, with the [Interval Type] line property.

If you select even, the numeral memory table entries are displayed in equal
intervals.

Even intervals

If you select uneven, the intervals between numeral memory table entries can be
set as desired.

Click on , and the interval setting dialog box is displayed.

Set number of dots
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Intervals can be set in the manner shown below.

Note that intervals are set as numbers of dots.

(1) Specify the point for which the interval is to be set. The field of the specified
point is displayed in reverse video.

(2) Change the width between points (the number of dots).

(3) Click on .

(4) After setting the interval for all point positions, click on .

� When displaying a broken-line graph, the display points are determined by cal-
culating the percentage value based on the values for 100%, 0%, and –100%.

If the 100% value, 0% value, and –100% value are set as indicated below, ref-
erence values are displayed in the broken-line graph as shown below.

Value referred to: 3000 100%

Value referred to: 1500 50%

Value referred to: 0 0%

Value referred to: –1000 –50%

Value referred to: –2000 –100%
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If the 100% value, 0% value, and –100% value are set using numeral memory
table entries as indicated below, the percentage value of the reference value is
calculated according to the value stored at the specified address.

Numeral memory
table

0

1

2

3

4

5

–2000
0

3000

6-9-4 Trend Graph
Changes in the contents of a numeral memory table entry with time are displayed
in the form of a trend graph.

0%

Numeral memory
table

80

Trend graph
100%

(1) The value in a numeral memory table entry is converted into percentage val-
ues at the set intervals, in the range from 0 to 100% or from –100% to 100%,
and displayed in the form of a trend graph.

Operation procedure

Selection using the menu bar: [Objects] → [Graph] → [Trend Graph]

Selection using the drawing toolbar:

Terminology

Frame

+Range

Display and control
touch switches

–Range

Line

Display %

(Only NT31, NT31C, NT631, NT631C)



6-9SectionGraphs

241

Property setting

General

Position: Indicates the display position of the trend graph.
(The reference point is at the upper left corner of the trend
graph)

Size: Indicates the size of the trend graph.

Display

Type: Specify the trend graph display type.
Standard, Pen Reco (pen recording)

Drawing Width: Specify the amount of graph shift when the display is updated.

Frame: Specify whether or not a frame is displayed for the trend graph.

Display Sign: Specify whether or not a display area for negative values is
displayed.

Direction: Specify the direction of trend graph movement.
Right ( → ), Left ( ← ), Up ( ↑ ), Down ( ↓ )

Sampling Cycle: Specify the graph updating time interval.

NT30, NT30C, NT620S, NT620C, NT625C: 0.1 second unit
NT21, NT31, NT31C, NT631, NT631C: 0.5 second unit

Color

Frame: Specify the color of the trend graph frame if [Frame] is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

+Range: Specify the color of trend graph displayed for a positive value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

–Range: Specify the color of trend graph displayed for a negative value.
(Can only be set for PTs with color display.)
Valid only when [Display Sign] is selected.
White, black, blue, red, magenta, green, cyan, yellow

Settings

: Specify this when displaying multiple graphs (lines). The line
properties [Line] are displayed.

: Specify this when deleting a graph (line).

: Specify this when modifying a graph (line). The line properties 
[Line] are displayed.

Logging Property (only for NT21, NT31, NT31C, NT631, and NT631C)

Data logging: Specify whether or not the data logging function is used.

Background: Specify whether or not the background function is used.
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Touch switches for logging

Next Page: 
(Forward)

Specify whether or not a touch switch used to
move the display range in the direction of newer
records is used.

Previous Page: 
(Rewind)

Specify whether or not a touch switch used to
move the display range in the direction of older
records is used.

Log Clear: 
(Clear log)

Specify whether or not a touch switch used to
clear all logged data is used.

Touch switches for display function

Restart :
(Continue)

Specify whether or not a touch switch used to restart
the halted data sampling is used.

Stop: Specify whether or not a touch switch used to halt
data sampling is used.

Display Clear:
(Clear display)

Specify whether or not a touch switch used to clear
the graph display is used. Note that the log data is
not cleared by this switch.

Line

Value

Table Entry: Specify the table entry number of the numeral memory table
entry whose contents are displayed in a trend graph.

Display %: Specify whether or not a percentage value is displayed on
the screen.

Line

Color: Specify the graph (line) color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Style: Specify the line type.
Solid, Dash, Dot-dash, Dot-dot-dash

100%

Table Entry: Specify this item if a 100% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a 100% value is set with a constant:
set the value to be taken as the 100% value.

0%

Table Entry: Specify this item if a 0% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a 0% value is set with a constant:
set the value to be taken as the 0% value.

–100%

Table Entry: Specify this item if a –100% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a –100% value is set with a constant: set the
value to be taken as the –100% value.
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Note that specification for –100% is valid only when [Display Sign] is selected.

Guidance

� Following types of trend graph element are provided.

0% to 100% display

Direction: Right

Direction: Left

Direction: Up

Direction: Down

→Time

↑Time

←Time

↓Time

–100% to 100% display

Direction: Right

Direction: Left

Direction: Up

Direction: Down

→Time

↑Time

←Time

↓Time

� Which of [0 to 100%] and [–100 to 100%] trend graphs is displayed should be
selected with the setting for [Display Sign] in the general attributes.

Check mark set: –100 to 100% display

Check mark not set: 0 to 100% display

� The following two types of trend graph display are provided.

Standard: The latest drawing position moves in the direction set for [Direc-
tion].

Present
drawing
position

Next
drawing
position
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Pen Reco: The latest drawing position is fixed and the entire graph moves in 
the direction set for [Direction].

Present
drawing
position

Present display status Present drawing position
Next
display
status

� If you specify a trend graph element, only one broken line is displayed.
To modify the settings for the line, select the line to be modified and click on

. The line properties are displayed.

To add a line, click on . A line is added and the line properties are
displayed for the added line. A maximum of 50 lines can be created.
To delete a line, select the line to be deleted with the “Settings” and click on

. The specified line is deleted.

� The following four types of line are provided for displaying trend graphs.

Dot-dot-dashSolid Dash Dot-dash

Set the line type with the [Style] property.

� The intervals between points of a trend graph in the time axis is specified by
[Drawing Width]. The width is set as a number of dots.

� The time intervals in which the drawing value of a trend graph is read is speci-
fied by [Sampling Cycle]. Set the interval in units of 0.1 seconds for NT30,
NT30C, NT620S, NT620C, NT625C and 0.5 seconds for the NT21, NT31,
NT31C, NT631, and NT631C.

� The latest drawing value of a trend graph can be displayed as a percentage
value.

In the default setting, a percentage value is displayed.
Whether or not a percentage value is displayed can be set with the [Display %]
line property.

Check mark set: A percentage value is displayed.

Check mark not set: A percentage value is not displayed.

� If the setting is for a percentage value to be displayed, the size and display
position of the value can be modified using the element edit function in the
manner shown below. (For detail of the element edit function, refer to page
110.)

(1) Click on a percentage value while pressing the Shift key and Ctrl key.

(2) Drag a percentage value to change the display position.

Example: Modifying the percentage value display position

(1) (2)
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(3) To change the size of a displayed percentage value, double click on the val-
ue.

The properties of the percentage value display are displayed.

Position: Indicates the display position of the percentage value.
(The reference point is at the upper left corner of the percentage
value.)

Font Type: Specify the font of a value to be displayed.
Standard, Half Height, Double Width

Scale: Specify the scale of a value to be displayed.
1�1 (Equal), 1�2 (High), 2�1 (Wide), 2�2, 3�3, 4�4, 8�8

Smoothing: Specify whether or not smoothing processing is executed for a
value to be displayed.

Attribute: The display attribute cannot be set (fixed as standard display).

Color

Foreground: Specify the color of the percentage value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the percentage value display
area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Reference: � A percentage value and other elements cannot be overlapped on a trend
graph.

� With a trend graph, a percentage value can be displayed for each line. If there
are too many lines with percentage values and the correspondence between
the values and lines is not clear, use the procedure shown below to check the
line that corresponds to the percentage value.

(1) Select a trend graph.

(2) Select [Edit] (menu bar) – [Edit Object].
Or press Insert key (P122).

The trend graph element enters the edit enabled state and the � marks
surrounding the trend graph change to red.
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(3) Select [Edit] (menu bar) – [Select Object]. (Place where graph or % display
does not exist.)

The components of a trend graph (trend graph, percentage values) are dis-
played in a list. The line numbers that correspond to the individual percent-
age values are displayed.

If you click a line in the list, the corresponding percentage value display is
selected in the screen to make the correspondence between the line and the
percentage value clear.

Instead of the operation in step (3) above, right-clicking the mouse on the trend
graph → [Edit Object] → right-clicking the mouse on the trend graph near by the
% display where % display and frame does not exist → [Select Object], the per-
centage values displayed near the click point are displayed in a list.

� When displaying a trend graph, the display points are determined by calculat-
ing the percentage value based on the values for 100%, 0%, and –100%.

If the 100% value, 0% value, and –100% value are set as indicated below, refer-
ence values are displayed in the trend graph as shown below.

Value referred to: 3000 100%

Value referred to: 1500 50%

Value referred to: 0 0%

Value referred to: –1000 –50%

Value referred to: –2000 –100%
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If the 100% value, 0% value, and –100% value are set using numeral memory
table entries as indicated below, the percentage value of the reference value is
calculated according to the value stored at the specified address.

Numeral memory
table

0

1

2

3

4

5

–2000
0

3000

� The data logging function and background function can be used with the NT21,
NT31, NT31C, NT631, and NT631C.

Data logging function

The data logging function records the values used for display at a PT.

Usually, the data collected in sampling for display in a trend graph are not re-
corded internally. If you use the data logging function, the data are logged and
can be displayed by tracing them back.

The data logging function can be executed for up to 8 kinds of data.

Background function

The background function continues data sampling even when a trend graph is
not displayed.

With a trend graph, data sampling is executed only when a trend graph is dis-
played and stops when the screen is switched from the trend graph screen.
However, if the background function is used, data sampling can be continued
in the background mode (while the trend graph is not displayed). The data
sampled and logged when in background mode can be displayed by tracing
back to the past.

The background function is valid only when it is used with the data logging
function; when the background function is used, the objective data is continu-
ously recorded. Please note that since data sampling is executed continuously
if the background function is used, the processing speed at a PT may be a little
slow.

� How the data recording is changed depending on whether or not the data log-
ging function and the background function are used is shown below. Regard-
less of the use of these functions, the trend graph element always starts draw-
ing a graph from the initial state when the screen is changed to the trend graph
display screen.

<Without logging and background functions>

Trend graph screen

Switching
the screen

Other screen

Returning

Trend graph screen
(starts drawing a graph newly)

Data not logged
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<With data logging function but without background function>

Trend graph screen

Switching
the screen

Other screen

Returning

Trend graph screen
(starts drawing a
graph newly)

Data logged Data not logged during this period

Previous data are re-displayed by pressing        (page return)

Data logged

The trend graph is drawn newly when the screen is switched back to the trend
graph display screen. However, it is possible to redisplay the past data drawn in
the trend graph previously by pressing a touch switch that has the function to dis-
play the past data. In this case, however, the data are not logged while a trend
graph is not displayed.

<With logging and background functions>

Trend graph screen

Switching
the screen

Other screen

Returning

Trend graph screen

Data is always logged

Past data are re-displayed continuously by pressing        (page return)

Although the trend graph starts displaying new data when the screen is
switched back to the trend graph display screen, it is possible to display the
data of the period during which the trend graph was not displayed by pressing a
touch switch that has the function to display the past data.

� The trend graph element can control data sampling, display and other related
operations using the special touch switches shown below.

These touch switches execute their function only once when they are pressed.

 Stop touch switch

Stops data sampling. Updating of a trend graph display is also stopped at the
same time.
While sampling is halted, the touch switch is lit.

If data sampling is executed by the background function, data sampling in the
background mode is also halted.

When the background function is not used, if the screen is switched back to the
trend graph display screen after halting data sampling and calling other screen,
the trend graph is redisplayed and logging restarts automatically.

 Restart (Continue) touch switch

Restarts halted data sampling. At the same time, updating of the trend graph dis-
play restarts.
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During data sampling, the touch switch is lit.

 Display Clear (Clear Display) touch switch

Clears the trend graph display. Even if the display is cleared, the logged data are
not cleared.

 Log Clear (Clear Log) touch switch

Clears all logged data. At the same time, the trend graph being displayed is
cleared. This switch clears only the trend graph being displayed. The trend
graphs registered on other screens are not cleared. This switch is valid only
when the data logging function is used.

 Previous Page (Rewind) touch switch

Displays the logged past data, older than the time range of the presently dis-
played graph. This switch is valid only when the data logging function is used.

 Next Page (Forward) touch switch

Displays logged data that is newer than the time range of the presently displayed
graph. This switch is valid only when the data logging function is used.

If the latest data is displayed while the data is being logged, updating of the trend
graph display automatically restarts.

Concerning the previous page touch switch and the next page touch switch, the
one pressed later is lit.

Reference: When the data of trend graph made with NT30, NT30C, NT620S, NT620C, and
NT625C were converted to the use for NT31, NT31C, NT631, and NT631C, if
touch switches for controlling trend graph is added after that, the Label of the
touch switch may not be appeared or some other marks may be appeared.
This is because the method of using marks of “FFEF to FFF5 (hexadecimal)
code” differs between NT30, NT30C, NT620S, NT620C, NT625C and NT31,
NT631, NT631C.
(With NT31, NT31C, NT631, and NT631C, they are used for touch switches for
controlling trend graph.)
Resetting the each mark of FFEF to FFF5 code with mark editor enables the cor-
rect display. For details, refer to Correcting the Screen Data Conversion (Correc-
tion related to control touch switch of trend graph) in Appendix A.
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6-10 Registering Created Elements (Symbol Manager
Operation)

The created graphic data can be collectively registered as an element by using
the Symbol Manager. The graphic data registered collectively in a group is called
symbol or symbol data.

By registering data that is often used by the Support Tool, it is possible to use the
same data among multiple screen data (Application).

Since the graphic data for creating a keyboard and keypads for each PT model
and color/pattern combinations of tiling objects are registered and provided with
the Support Tool, you can save time when creating graphics.

6-10-1 Screen Configuration of Symbol Manager
The symbol manager screen configuration is shown below.

Symbol name

Menu bar

Symbol icon

Folder

Folder name

A folder represents one symbol data file, and symbols displayed under the folder
represent the individual symbol data registered in that file.

The name of the selected folder, or the name of the file that stores the selected
symbol is displayed in the title column of the Symbol Manager window.

Starting with V4.6, there is a Preview pane to show an overview picture and a
Listing pane to show the object contents.

For newly installed symbol data with V4.6, the preview is immediately available.
Old data can be reused into this version but a preview is not applicable. To make
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a preview of old data, copy the data to the screen on V4.6 and then copy it back to
the symbol manager to register the preview information.

File configuration

The symbol manager is controlled in a data file that is separate from the screen
data file.

The symbol data file configuration is shown below.

NTST4.7\Symbol SPPLMNT.SBL

SYMFILE1.SBL

SYMFILE2.SBL

SYMFILE3.SBL

File storing the keyboard and keypad data

Group of files storing newly registered symbols
A file is created for each symbol

Color PL. SBL File storing tiling objects

Reference: For the Support Tool, keyboard data for each PT model, color palette and ISO
elements are provided as symbol data.
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6-10-2 Basic Symbol Manager Operation
Starting up the symbol manager

(1) [Window] (menu bar) → [Symbol Manager]

Reference: � The symbol manager window is always displayed at the top of the windows dis-
played on the screen. If this disturbs your operation, minimize the window by
either clicking on the  button at the upper right area in the window or select-
ing the [minimize] item from the control menu box displayed by the clicking on
the button at the upper left area in the window.

� The symbol manager memorizes the folder that was open when you quit the
symbol manager last time and opens the same folder automatically when you
next start the symbol manager. The symbol registration state in the folder is,
however, the state when the folder was saved last.

Basic operation

� Menu bar

File New: Creates a new file (folder).

Open: Displays a file (folder) that is not displayed in the screen.

Close: Closes the file (folder) presently displayed in the screen.
(The file is not deleted although it disappears from the
screen.)

Save: Saves the specified folder by overwriting the present file.

Save As: Saves the specified folder by changing the file name.
(Folder name remains unchanged.)

Save All: Saves all folders to the individual files.

Exit: Lets you exit the symbol manager.

Edit Cut: Moves the specified symbol data to the clip board.
(The data is deleted from the symbol manager.)

Copy: Copies the specified symbol data to the clip board.
(The data remains in the symbol manager.)

Paste: Pastes the symbol data, stored in the clip board by cut or
paste, to the active screen.

Delete: Deletes the specified symbol data from the symbol manag-
er. (The data is not stored in the clip board.)

Choose Icon: Changes the icon design of the symbol data.

Change Label: Changes a folder or symbol name.

View Status Bar: Specifies whether or not the status bar, which
displays menu item functions, etc., is displayed un-
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der the window. In the menu, if there is a check mark
to the left of [Status Bar], the status bar is displayed.

Help Contents: Displays the help information.

Search for Help on: Enables you to display help information
on the input word.

About Symbol Manager: Displays information such as the ver-
sion of the symbol manager.

� Screen Operation

Double click on the folder or symbol name,
and the folder opens to display the list of
registered symbol data.
Double clicking on the folder or symbol
name while the list of the registered symbol
data is displayed causes the folder to close
so that only the folder name is displayed.

“+” indicates that symbol data is registered for the folder. “–”
is displayed when the folder is open.
Clicking on this has the same effect as double clicking on the
folder name.

Reference: Folders are displayed in the alphabetical order of the folder names. In a folder,
the list of symbol data displays the symbol data in the alphabetical order of the
symbol names.

6-10-3 Operating the Symbol Manager
Opening a folder (file)

Open a folder in which symbol data is registered.
By opening the symbol collections supplied with the Support Tool or the files
saved by the symbol manager (P274), it is possible to display the opened data in
the symbol manager and to use the required one for screen creation.

Reference: � The following symbol data files are supplied with the Support Tool.

Color Palette Symbol (ColorPL.SBL)

Keyboard/Keypad Collection (Spplmnt.SBL)

ISO Symbol Collections (ISO7000 (XXXX-XXXX).SBL) (CD-ROM version
only)

� The opened folders (symbol data files) in the symbol manager remain dis-
played until they are closed. The symbol manager memorizes the folder con-
figuration when you quit the symbol manager last time and displays the same
state when you next start the symbol manager. (The symbol registration state
in the folder is the state when the folder was saved last.)

� While registering a symbol from a screen or pasting it to a screen, the folder to
be used (symbol data file) should be opened. However, if the symbol data file
has a Read-only property, the characters “Read Only” are displayed in the
symbol manager. In this case, it is not possible to perform symbol registration.
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(1) Select [File] in the menu bar, then select [Open].

The dialog to specify the file name is displayed. In the dialog, the folders that
contain the symbol data file to be read are displayed. (File type is fixed to a
Symbol File (*.SBL))

(2) Specify the desired folder and file name and click on .

Opened symbol data file is displayed in the symbol manager.

Ex: Opening ISO Symbol file (ISO7000 (0001-0099).SBL)

Closing a folder (file)

Close the unnecessary folder (symbol data file) to remove it from the symbol
manager.

(1) Select the folder that should be closed in the symbol manager. The folder
name is displayed in reverse video.

(2) Select [File] in the menu bar, then select [Close].

If the file has not been saved, the message asking you whether to save it or
not is displayed.

(3) If you click the  Button, the window to specify the file name is dis-
played.

Specify the file name and save it. (If you click the  Button in the file

name specifying window, the symbol folder closes without being saved. If
you click the  Button, the symbol folder closes without being saved.
(Registered symbol will be discarded.) For details on saving, refer to Saving
a folder (file) on page 256.

Creating a new folder

Create a new folder to register the symbol data by the procedure shown below.

By collecting symbols related with each other in the same folder, the screen data
creation operation can be facilitated since searching for symbol data is simple.

Select [File] in the menu bar, then select [New].
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A new folder is named as “No description.”

� Changing folder name

To change the folder name to one that is easy to understand, follow the opera-
tion shown below.

(1) Select the folder name that should be changed. The folder name is dis-
played in reverse video.

(2) Select [Edit] in the menu bar, then select [Change Label].
The label name change dialog box is displayed.

(3) Set the desired folder name and click the  Button.

Registering the symbol data

A graphic consisting of several elements is registered as a single element
(symbol).

After registering the symbol data, be sure to perform the file save operation.

To register the symbol data, select the elements to be registered collectively and
drag them to the symbol manager folder where they are to be registered.

Drag the symbol to the desired folder, then release the mouse.

The element in the source screen remains as it is.

For a new symbol, symbol name “New Symbol x” (x is a serial number) is as-
signed.

Reference: The symbol data can be registered also by the following operation.

(1) Select the elements to be registered in the source screen and select [Copy]
or [Cut] from the [Edit] menu in the Support Tool.

(2) Select [Paste] from the [Edit] menu in the symbol manager.
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In this case, symbol name “Pasted Symbol x” (x is a serial number) is assigned
for a new symbol.

� Changing the symbol name

To change the symbol name to the one easy to understand, follow the opera-
tion shown below.

(1) Select the symbol name that should be changed. The symbol name is dis-
played in reverse video.

(2) Select [Edit] in the menu bar, then select [Change Label].
The label name change dialog box is displayed.

(3) Set your desired symbol name and click the  Button.

� Changing the symbol icon

It is possible to change the icon of the symbol data to a desired one. To change
the icon, follow the procedure shown below.

The data that can be used for an icon is bit map data.

(1) Select the symbol for which the icon should be changed. The symbol name
is displayed in reverse video.

(2) Select [Edit] in the menu bar, then select [Choose Icon].

The data selection dialog box is displayed.

(3) Specify the bit map data that should be used as an icon and click on
.

Reference: For an icon, 16�16-dot, 8-color bit map data can be used. Although bit map data
larger than 16�16 dots can be used, only the 16�16 dots at the upper left area
of such data is used.

Saving a folder (file)

After registering the symbol data, save the registered data to a file by the opera-
tion shown below.

Select [File] in the menu bar, then select [Save], [Save As], or [Save All].

If there is a folder that has not been saved, the file name specifying window is
displayed regardless of the save method you chose. If this window opens, speci-
fy the file name to save the folder. Please note that the file name specifying win-
dow does not show the objective folder name, which means that the objective
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folder for saving cannot be distinguished if you select [Save All] when there are
several unsaved folders. It is advisable to save a folder that has not been saved
by assigning a file name beforehand.

Overwrites the file where the symbol data was originally
stored with the symbol data in the specified folder.

Saves the symbol data of the specified folder to the file of the
specified file name.

Overwrites the individual original files with the symbol data
that was open.

Reference: Before executing [Save] or [Save As], click the object folder.

Copying/deleting the registered symbol

Registered symbols can be moved or copied to another folder or deleted.

To move, copy, or delete a registered symbol, select [Edit] in the menu bar, then
select the required function ([Cut], [Copy], [Paste], [Delete]).

Moves the specified symbol to the clip board.
The specified symbol is deleted from the source folder.

Copies the specified symbol to the clip board.
The specified symbol remains in the source folder.

Pastes the symbol, stored in the clip board by the cut or copy
function, to the currently selected folder.

Deletes the specified symbol.
The symbol is not stored in the clip board.

Move or copy of a symbol is also possible by dragging the symbol using the
mouse.

� If a symbol is dragged to another folder, the symbol is moved.

� If a symbol is dragged to another folder while the Ctrl key is held, the symbol is
copied.

In these operations, the “+” mark is displayed at the mouse cursor.

6-10-4 Pasting a Symbol to Screen
To paste a registered symbol to the data creation screen of the Support Tool, se-
lect the symbol and drag it to the desired position on the data creation screen,
then release the mouse.

The symbol is copied to the data creation screen.

Drag the symbol to the data creation screen and release the mouse.

The symbol copied to a data creation screen can be used in the same manner as
other elements.
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Reference: � Symbols created by different PT models can be pasted to a data creation
screen. In this pasting operation, the symbol data is automatically converted
and, if an error occurred in data conversion, an error message is displayed. For
details, refer to Appendix A Data Conversion.

� Concerning image/library data, only the code is registered at the symbol man-
ager. Therefore, if the image/library data is pasted to another screen data file,
the image/library data of that code in the file to which the data was pasted is
displayed.

� If the ISO symbols, supplied by the CD-ROM version Support Tool, are used
with NT20,  NT20S, or NT600S, those symbols that consist of elements that
are not supported may not be displayed correctly.

� Image/library collection, supplied by the CD-ROM version Support Tool, can
be used only with models that can use image/library.

Pasting an ISO symbol

To paste an ISO symbol to the data creation screen of the Support Tool, select the
symbol and drag it to the desired position on the data creation screen, then re-
lease the mouse. (Same operation as the other symbols.)

Drag the symbol to the data creation screen and release the mouse.

Reference: It is not possible to change the colors and size of ISO symbols, since the ele-
ments are registered in the grouped status.

6-10-5 Operating Procedure of Color Palette Symbol
Color palette symbol

Color palette symbol is a symbol for which tiling objects are registered with their
tiling patterns, foreground and background colors respectively combined. You
can select required tiling objects while checking the tiling status on screen.

Color palette symbol is separated into tiling patterns and each pattern is set as
one symbol as shown below. Combinations of foreground and background col-
ors are registered for each symbol.



6-11SectionRecipe Screen Element

259

Operation procedure

Follow the procedure below to use color palette symbol.

1. Open new screen to place color palette on it.

2. Drag required tiling pattern symbol from palette symbol and drop it on the
screen created in 1.

3. Select [Ungroup] from the [Draw] menu to cancel the grouped status (default
status) after confirming that the dragged symbol is in selected status.

4. Clear the check mark for [Full Tiling] from the [View] menu to select the tiling
object easily after you decided which one to use, then drag it to the objective
screen while depressing [Ctrl] key (or perform copy&paste). To check the til-
ing status, select [Full Tiling] from the [View] menu. However, in this status,
the position of tiling object will not be clear. Cancel the [Full Tiling] status when
required.

5. Border color of tiling objects in color palette symbol is set to White. Change
the border color of tiling object by displaying property sheet if required. 
Note that the transparent background color is not registered for color palette
symbol. Change the property afterwards when you want to apply transparent 
background.

6-11 Recipe Screen Element

6-11-1 Recipe Screen Element
Recipe screen element provides you with an interface to apply a set of data val-
ues from the recipe table to the PLC.

It can only be placed on a standard screen and it can be displayed in the parent
screen. The screen element property dialog box has 4 pages – general, touch
switch, setting and interlock.

Operation procedure

Selection using the menu bar: [Objects] � [Data Input] � [Recipe]

Selection using the drawing toolbar:  

Terminology

Description of Recipe Screen Element Components

Name

Specifies the recipe name.
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SECTION 7
Memory Table Setting

Memory tables are areas in a PT for storing numeric value data and character string data. These areas are used for communicat-
ing with PC (PLC).
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7-1 Common Operation
The operating procedures common to all memory tables are described below.

Copy setting button

Edit button

Batch address change button

Search buttonReference button

Specified number display button

Set button

Operation starts by specifying the number, that is, clicking on the objective line
(memory table entry number). The shape of the mouse cursor changes as shown
below when it enters the No. field.

7-1-1 Reference Operation
The reference screen displays the screen numbers and the table entry numbers
in which the specified table entry is used, in the form of a list, and the screen or
element that corresponds to the specified table entry is displayed.

Reference: Reference operation is valid only when a memory table window is opened with
the [Tools] → [Table] operation. If the memory table window is called from the ele-
ment property dialog box, reference operation is not possible.

Description of reference dialog box

Table Entry

Displays the selected table entry number.

Screen/Table

Displays the screen number or the table entry number where the specified table
entry is used.
Whether the displayed number is a screen number or a table entry number can
be determined from the displayed number as shown below.

For screen numbers, only a number is displayed.
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For table entry numbers, a number is preceded by a code that represents the
table type.

The codes representing table types are summarized below.

Code Table type

N Numeral memory table

S Character string memory table (String table)

B Bit memory table

I Extended I/O input table

O Extended I/O output table

M Mathematical table*1

*1 Reference operation is slightly different for mathematical table. When a math-
ematical table entry is created with numeral table entry as either operand or re-
sult, a reference is created to the corresponding entry in numeral table. When
operand/result is PLC address, a reference is created to the corresponding ad-
dress entry in I/O comment table.

Comments

Displays screen comments corresponding to a screen number.

No. of References

Displays the number of appearances of the screen or the table entry.

Operation

(1) Click on the table entry number of the reference memory table entry.

(2) Click on . List of referenced screen/table entry number is dis-
played.

(3) In the reference dialog box, specify the objective screen/table entry number
and click on .
As an alternative to the operation above, you may double click on the objec-
tive element.

The specified screen automatically opens to display the specified element.

7-1-2 Search Operation
You can locate specific data set in a table by using the search operation, and also
replace the found data with the desired data.

Search and replacement is possible for the following types of memory table.

Note that search and replacement is always executed toward the end of a table.
This means that search and replacement is possible within the range from the
present cursor position in the table to the last entry number in the table.

Table Type Objective of Search/Replacement

Numeral memory table PC (PLC) address, initial value

Character string memory table
(String table)

PC (PLC) address, contents of initial val-
ue

Bit memory table PC (PLC) address, image/library code
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Table Type Objective of Search/Replacement

I/O comment table I/O comment

Extended I/O input table –––

Extended I/O output table –––

Description of search dialog box

PC (PLC) address Initial value or contents of initial value

Image/library code I/O comment

Search By

Specify the objective data for the search or replacement operation.

PC (PLC) address: Data set for addresses of table entries.

Initial value (contents): Data set for the initial values of a numeral memory table
entry or character string memory table entry (string
table).

Image/library code: Image/library codes set for a bit memory table entry.

I/O comment: I/O comment in I/O comment table.

Find What

Set the data to be searched for or replaced.

Replace With

Set the new data to replace the data set for [Find What].

Clicking this button starts search processing.

When the specified data is found, the cursor in the table automatically moves to
the found table entry number.

Search for the next appearance by clicking on this button again.

Clicking this button starts replace processing.

The data specified for [Find What] is searched for and replaced with the data set
for [Replace With].
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When the specified data is found, the cursor in the table automatically moves to
the found table entry number.

Search for the next appearance by clicking on this button again.

Clicking this button starts replace processing.

The data specified for [Find What] is searched for and replaced with the data set
for [Replace With].

All appearances are replaced with the specified data at one time.

Operation procedure (search)

(1) Specify the table address (the start position of the search range).

(2) Click on .

(3) Select the objective of the search in the [Search By] box.

(4) Specify the search objective data in the [Find What] box.

(5) Click on .

Operation procedure (replace)

(1) Specify the table address (the start position of the replace range).

(2) Click on .

(3) Select the objective of replace in the [Search By] box.

(4) Specify the data to be replaced in the [Find What] box.

(5) Specify the data to replace the old data in the [Replace With] box.
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(6) Click on  or .

D00000

D00030

7-1-3 Batch Address Change Operation
The set PC (PLC) addresses can be changed into the required addresses in a
batch. Since the change source can be specified as a range, processing such as
changing the address range DM1000 to DM01499 to the address range DM1800
to DM2299 is possible at one time. Shifting in bit units is also possible.

Note that the batch address change operation is allowed only for displayed table
entries.

Independent with the location of the cursor, this address change will be per-
formed to the whole table.

Description of batch address change dialog box

Find – Channel (Word)

Specify the word type of the batch change source.

Find – Start Range

Specify the start address of the source range for the batch address change.

Find – End Range

Specify the end address of the source range for batch address change.

The address to be set for [End Range] must always be larger than or equal to the
address set for [Start Range].
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Change to – Channel (Word)

Specify the word type and start address after the change.

Addresses are changed within the number of specified points from the start ad-
dress (number of points from “Start Range” to “End Range”).

Change Comment

Specify whether or not the same I/O comment appended to an address before
the change is appended to the address after the change.

To append the same I/O comment, click on the check box to display a check mark
in it.

Batch address change processing starts when you click on this button.

How addresses are changed

In the operation for changing addresses in bit units, processing is executed as-
suming that bit 15 of a word is immediately followed by bit 0 of the next word.

Addresses are changed as shown below according to the set search range and
the address after the change.

Example: Bit memory table

15 10 0

[Change To] – [Address] 
(start address after the change)

Address and Bit set 
for [Start Range]

CIO area Word 0CIO area Word 1

Bit 15 0

Address and Bit set 
for [End Range]

15 0Bit 15 0

HR area Word 10HR area Word 11

Before change After change

0000010 H0001000

0000012 H0001002

0000100 H0001006

0000110 H0001100

0000115 H0001105

Operation procedure

(1) Click on .

(2) Select the type of word before the change in the [Channel] box.

(3) Specify the range of the change by setting addresses at the [Start Range]
and [End Range] boxes.

(4) Specify the word and the address after the change in the corresponding
boxes in the [Change To] area.
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(5) Set a check mark in the Change Comment check box as desired.

If a check mark is set in this check box, I/O comments appended to the ad-
dresses before the change are also appended to the addresses after the
change.

(6) Click on .

7-1-4 Edit Operation
The procedure for clearing, cutting, copying, pasting, and incremental copying of
the data set in a memory table is described below.

In the “copy to next” operation, the specified incremental amount is automatically
added to the data in the memory table entry at the cursor location and copied to
the memory table entry with the next number.

The procedure for specifying the incremental amount to be used for “copy to
next” is explained in 7-1-5 Copy Increment Setting Operation.

Reference: � To start editing, click on  or right click the mouse on a table entry
number to display the menu, then select the desired edit function in this menu.
It may not be possible to select an edit function if an input field is displayed. If
the selection of an edit function is not possible, left click the mouse on a table
entry number field to select the entire line and, after that, click on 
or right click the mouse on a table entry number to display the menu.

� When the two screen data files of the same PT model are opened using [Import
Component] command, it is possible to paste the table data that was cut/co-
pied by one Support Tool to a table of another Support Tool. (For details, refer to
3-3-6 Importing Components from Different Screen Data File (Starting Up the
Second Support Tool).)

Clear

Clears the data in the selected memory table entry.

Cut

Cuts the data in the selected memory table entry and stores it in the clipboard.

The cut data can be pasted to another memory table entry.

Copy

Copies the data in the selected memory table entry to the clipboard.

The copied data can be pasted to another memory table entry.

Paste

Pastes the data stored in the clipboard by the cut or copy function to the memory
table entry at the cursor position.
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Copy to Next

Executes the “copy to next” operation.

How this function is executed differs according to the table type as shown below.

Table Type
Increment Item

Table Type
Initial Value PC (PLC) Address

Numeral memory table Addition processing Addition processing

Character string memory table
(String table)

Cannot be specified. Addition processing

Bit memory table Cannot be specified. Addition processing

Extended I/O input table Cannot be specified.

Extended I/O output table Cannot be specified.

Operation procedure (Clear)

The clear function clears the data at the specified address of a table.

Since the data is not stored in the clipboard, the data deleted by the clear function
cannot be restored by the paste function.

(1) Click on the table entry number of the data to be cleared.

(2) Click on  or right click the table entry number.

(3) Select [Clear].

Operation procedure (Cut)

The cut function cuts the data at the specified address of a table and stores it in
the clip board.

The data deleted by the cut function can be used for pasting.

(1) Click on the table entry number of the data to be cut.

(2) Click on  or right click the table entry number.

(3) Select [Cut].

Operation procedure (Copy)

The copy function copies the data at the specified address of a table to the clip
board.

The data copied by the copy function can be used for pasting.

(1) Click on the table entry number of the data to be copied.

(2) Click on  or right click the table entry number.

(3) Select [Copy].

Operation procedure (Paste)

The paste function pastes the data stored in the clip board by the cut or copy op-
eration to the specified table entry.

(1) Click on the table entry number of the table where the data is to be pasted.

(2) Click on  or right click the table entry number.

(3) Select [Paste].
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Operation procedure (Copy To Next)

The “copy to next” function copies the data at the specified address of a memory
table to the next address after adding the specified amount to the existing data.

The procedure for specifying the incremental amount is explained in 7-1-5 Copy
Increment Setting Operation.

(1) Click on the table entry number of the copy source table.

(2) Click on  or right click the table entry number.

(3) Select [Copy To Next].

7-1-5 Copy Increment Setting Operation
To set the incremental amount used for the “copy to next” operation, follow the
steps described below.

Copy Increment Setting dialog box

Value – Increment By

Specify the incremental amount for the initial value data in a numeral memory
table entry.

The amount set here is valid only for the numeral memory table.

Value – Input Type

Specify whether the incremental amount is specified in decimal or hexadecimal.

The specified item is identified by the � indication of a radio button.

The setting is valid only for the numeral memory table.

Address – Increment By

Specify the incremental amount for table addresses.

Address – Format

Specify whether the incremental amount is specified in decimal or hexadecimal.

The specified item is identified by the � indication of a radio button.

Operation procedure

(1) Click on .

(2) Specify the incremental amount to be added to the initial value in the numer-
al memory table at [Value] – [Increment By].

(3) Specify whether the notation of the incremental amount set above is decimal
or hexadecimal at [Value] – [Input Type].

(4) Specify the table address incremental amount at [Address] – [Increment By]

(5) Specify whether the notation of the incremental amount set above is decimal
or hexadecimal at [Value] – [Input Type].
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(6) Click on  to close the dialog box.

(7) Click on the table entry number of the copy source table.

(8) Click on  or right click the table entry number.

(9) Select [Copy to Next].

7-1-6 Table Display Operation by Specifying the Table Entry Number
� Description of [Go to] dialog box

Entry

Specify the table entry number of the table to be displayed.

The cursor moves to the specified table entry number.

Operation procedure

(1) Click on .

(2) Specify the table entry number of the table to be displayed.

(3) Click on .

7-2 Numeral Memory Table
Numeral Memory Table

The numeral memory table is an area provided in a PT to store numeric value
data.

A numeral memory table entry is allocated to one or two words in a PC (PLC) and
the numeral memory table entry used for display can be shared with the PC
(PLC).
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With elements such as numeral display, graph, and numeral input, reading/writ-
ing of a numeric value is executed by specifying the numeral memory table entry
number.

PC (PLC)

Initial value
Initialization

Storage type
No. of words
PC (PLC) 
address
I/O comment
Reference

Numeral memory 
table

 1234Numeral display 
element

 2345Numeral data 
input element

Bar graph

0

1

2

3

4

5

Screen
PT

Read

Write

Read
Shared

Shared

Shared

7-2-1 Operation Procedure
A numeral memory table entry is displayed by the operation described below.

� At the property settings for individual elements, click on  in the table entry
number field.

� Select [Tools] (menu bar) → [Table], then click the [Numeral] tab.

Setting

For numeral memory table entries, the objective of an operation is specified by
clicking on a line. The necessary setting can be made by input using a keyboard
or by selection using a drop-down list.

For the operation procedure for , , ,
, , and , refer to 7-1 Common Operation.

(Note that  cannot be used if it is displayed by the operation using an
element property.)

Reference: For PT models other than NT20, NT20S and NT600S, numeral memory table
entries No. 247 to No. 255 are used by the clock function and, therefore, cannot
be allocated to a PC (PLC).

7-2-2 Related Elements
� When reading numeral data from a numeral memory table entry

Numeral display element
[Objects] → [Numeral Display]

Bar graph element
[Objects] → [Graph] → [Bar Graph]

Analogue meter element
[Objects] → [Graph] → [Analogue Meter]

Broken-line graph element
[Objects] → [Graph] → [Broken-line Graph]

Trend graph element
[Objects] → [Graph] → [Trend Graph]
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Image object (Indirect reference)
[Objects] → [Fixed Display] → [Image Display]

Library object (Indirect reference)
[Objects] → [Fixed Display] → [Library Display]

Standard lamp (Label type: Numeral display)
[Objects] → [Lamp] → [Standard] → ([Edit] in the Label property of standard
lamp)

Touch switch (Label type: Numeral display)
[Objects] → [Touch Switch] → ([Edit] in the Label property of touch switch)

� When writing numeral data to a numeral memory table entry

Numeral input element
[Objects] → [Data Input] → [Numeral]

Thumbwheel switch element
[Objects] → [Data Input] → [Thumbwheel Switch]

� When copying numeral data between numeral table entries, or when setting a
constant for a numeral memory table entry

Touch switch (copy setting)
[Objects] → [Touch Switch] → [Settings-Copy Setting] in property sheet

7-2-3 Description of Numeral Memory Table Fields

The display format varies slightly depending on the PT model. The example
screen shown above is for the NT21, NT31, NT31C, NT631, and NT631C.

Value

Specify the initial value to be set when the power is switched ON, the PT is reset,
or the mode is changed from the System Menu to RUN.

The range of values that can be input in this field is shown below.

PT Model Input Type Input Range

Other than NT21, NT31,
NT31C NT631 and

BCD F9999999 to 99999999
NT31C, NT631, and
NT631 Hexadecimal 00000000 to FFFFFFFF*1

NT21, NT31, NT31C, Decimal –2147483648 to 2147483647NT21, NT31, NT31C,
NT631, and NT631 Hexadecimal $00000000 to $FFFFFFFF*2
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*1: F in the most significant digit position (8th digit) indicates a negative value.

*2: With the NT21, NT31, NT31C, NT631, and NT631C, a hexadecimal num-
ber can be input by entering $ at the beginning of a numeric value. The input
hexadecimal value is converted to decimal for display.

For PT models other than the NT21, NT31, NT31C, NT631, and NT631C, the
input 8-digit hexadecimal value is simply stored as it is; there are no distinctions
between BCD and hexadecimal for these models. If the input numeric value is
displayed in BCD format, F in the most significant digit position (8th digit) is
treated as a negative sign.

With the NT21, NT31, NT31C, NT631, and NT631C, the input numeric value is
stored after conversion to signed binary data (2 words).

Setting of an initial value is valid when the resume function is not selected and the
[Initial] item is selected for the numeral memory table entry, and in this case the
content of the numeral memory table entry is returned to the initial value. If the PT
has the memory table initialization function, this function can also be used to re-
turn the content of a numeral memory table entry to the initial value.

Initial

Specify whether or not the content of the numeral memory table entry is written to
the allocated word in the host when the PT is switched on or reset, or the mode is
changed from the System Menu to RUN.

The term “initialize” means the processing to initialize the content of a word in the
host with the content in a numeral memory table entry. The setting for [Initial] is
not valid if the numeral memory table entry is not allocated to a word in the host.

To make the [Initial] item valid, click on the check box to display a cross mark (�)
in the box. If the box is clicked on while it is in the valid state, the [Initial] item is
made invalid.

Reference: The content of numeral memory table entries at the start of PT operation is as
shown below according to whether or not a numeral memory table entry is allo-
cated to the host, the [Initial] setting for the numeral memory table entry, and
whether or not the resume function is used.

Allocation to [Initial] Resume FunctionAllocation to
Host

[Initial]
setting Used Not Used

Allocated Initialized
(valid)

Existing numeral memory
table value retained
(also for the word in the
host)

Initial value of the numer-
al memory table
(also for the word in the
host)

Initial value of the numeral memory table entry if it is
initialized by System Menu operation
(also for the word in the host)

Not initialized
(invalid)

Content of word in the host

Not allocated (Invalid) Existing numeral memory
table value retained

Initial value of the numer-
al memory table entry

In case numeral table entry has been initialized in
the system menu operation, initial value of the nu-
meral memory table entry

Storage Type (only for the NT21, NT31, NT31C, NT631, and NT631C)

Specify if a numeral in the PC (PLC) is treated as BCD or binary data when read-
ing/writing the content of a PC (PLC) word to which a numeral memory table
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entry is allocated. This setting is valid only for the NT21, NT31, NT31C, NT631,
and NT631C. With other PT models, numeric values are always treated as BCD.

BCD: The content of an allocated word is regarded as BCD 
(binary coded decimal).

When the content of an allocated word is read, it is stored as signed
binary data. If F is set at the most significant digit position in the allo-
cated word, the content is regarded as a negative value. If an error is
found in the content of an allocated word (A to E at the most significant
digit position or A to F in other than at the most significant digit position),
the read out content is not stored in a numeral table. (The previously
stored content remains in the numeral table.)

When data is written to an allocated word, the signed binary data in the
numeral memory table entry is converted into BCD before writing. If a
negative value is written, F is entered at the most significant digit posi-
tion. (In this case, the number of storable digits is reduced by one.) If
the number of digits in the content of a numeral memory table entry is
greater than the number of digits of the allocated word in the PC (PLC),
only the numeric value is written from the least significant digit value.

Binary: The content of an allocated word is regarded as binary data.

When reading the content of the allocated word, the read content is
stored in a numeral memory table entry without change.

When writing a numeric value to the allocated word, the content of the
numeral memory table entry is written as it is. If the number of digits in
the content of a numeral memory table entry is greater than the number
of digits of the allocated word in the PC (PLC), only the numeric value is
written from the least significant digit value.

System: Conforms to the setting for [Numeral Display Type] of [System] in the
PC (PLC) Configuration.

Words

Specify the number of words to be allocated to a numeral memory table entry.
The possible specifications are 1 and 2.

� If the setting is 1 word, the 4-digit BCD or binary data is shared by the PT and
PC (PLC).

� If the setting is 2 words, the 8-digit BCD or binary data is shared by the PT and
PC (PLC).

When the setting is 2, the 1st to 4th digit data is allocated to the lower digit word in
the PC (PLC) and the 5th to 8th digit data is allocated to the higher digit word.

� PT models other than the NT21, NT31, NT31C, NT631, and NT631C

If the setting has been made to display a sign, one digit (bit 4) in the most signifi-
cant digit position is regarded as representing a sign; if F (1111 in binary) is set,
the numeric value is regarded as negative and if any other code is set, the numer-
ic value is regarded as positive. Therefore, if the numeric value is displayed with
a sign, the maximum number of significant digits of a negative value is 3 if 1 word
is set and 7 if 2 words is set.

Example: When 1 word is set, the value –123 is treated as F123 in hexadecimal
in a numeral memory table entry.
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Similarly, when 2 words are set, the value –1234567 is treated as
F1234567 in hexadecimal in a numeral memory table entry.

� PT models NT21, NT31, NT31C, NT631, and NT631C

Regardless of the number of allocated words, 2 words are always secured for a
numeral memory table entry and a numeric value is stored as signed binary
data. If the setting for [Storage Type] is decimal, F appearing at the most signifi-
cant digit position is treated as a negative sign. In this case, therefore, the num-
ber of significant digits of a negative value is one digit less than the number of
significant digits of a positive value, as with conventional PT models.

Example: If the settings are BCD and 1 word, the value –123 is treated as F123
in a PC (PLC) word and FFFFFF85 in a numeral memory table entry.
However, the value F123 in a PC (PLC) word is 0000F123 (61731 in
decimal) in a numeral memory table entry if the [Storage Type] is
hexadecimal.
Similarly, if the settings are BCD and 2 words, the value –1234567 is
treated as F1234567 in a PC (PLC) word and FFED2979 in a numer-
al memory table entry. However, the value F1234567 in a PC (PLC)
word is F1234567 (–249346713 in decimal) in a numeral memory
table entry if the [Storage Type] is hexadecimal.

Example

In PC (PLC)
Word

Write To No. of Words Storage Type In Numeral Memory Table

F123 ↔ 1 word BCD FFFFFF85
(in decimal: –123)

↔ 1 word Binary FFFFF123
(in decimal: –3805)

F1234567 ↔ 2 words BCD FFED2979
(in decimal: –1234567)

↔ 2 words Binary F1234567
(in decimal: –249346713)

4567 → 1 word BCD 000011D7
(in decimal: –4567)

→ 1 word Binary 00004567
(in decimal: –17767)

F567 ← 1 word BCD FFED2979
(in decimal: –1234567)

2979 ← 1 word Binary FFED2979
(in decimal: –1234567)

Note If only one word is allocated although two words are necessary to express a nu-
meric value, only the lower 4 digits of a numeric value are read or written. A suffi-
cient number of words must be allocated for reading/writing a numeric value.

PLC Address
Specify the PC (PLC) address (start address) of the area where numeral memory
table entries are allocated.

I/O Comment
Specify a comment for a PC (PLC) word.
A comment can comprise up to 16 characters.
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Ref
Indicates whether the table entry with the specified number is already used or
not.

Yes: Already used as an element.
No: Not used.

If the indication is Yes, you can check where the table entry in question is used by
clicking on .

(For details of , refer to 7-1-1 Reference Operation.)

7-3 Character String Memory Table (String Table)
The character string memory table (String table) is an area provided in a PT to
store character string data.

A character string memory table entry (string table) is allocated to 1 to 20 words in
a PC (PLC) and a character string memory table entry (string table) used for dis-
play can be shared by the PT and the PC (PLC).

It is possible to insert mark data, image data or library data into a character string.
Note that, however, NT11S/NT11, NT20, NT20S and NT600S do not have image
data and library data. With the NT21, NT31, NT31C, NT631, and NT631C with-
out NT20/30/620-compatible mode, it is not permissible to insert image data and
library data into a character string.

With elements such as character string display and character string input, read-
ing/writing of character string data is executed by specifying the character string
memory table entry (string table) number.

PC (PLC)

Initial value
Initialization
No. of words
PC (PLC) 
address
I/O comment

Reference

Character string 
memory table
(String table)

 OMRON
Character string 
display element

 PTCharacter string 
input element

0

1

2

3

4

5

Screen

PT

Read

Write

Shared

Shared

7-3-1 Operation Procedure
A character string memory table entry (string table) is displayed by the operation
described below.

� At the property settings for individual elements, click on  in the table entry
number field.

� Select [Tools] (menu bar) → [Table], then click [String] tab.

Setting

For character string memory table entries (string table), the objective of opera-
tion is specified by clicking on a line. The necessary setting can be made by input
using a keyboard or by selection using a drop-down list.
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: Inserts mark data.
: Inserts image data.
: Inserts library data.

For the operation procedure for , , ,

, , and , refer to 7-1 Common Operation.

(Note that  cannot be used if it is displayed by the operation using an

element property.)

7-3-2 Related Elements
� When reading from a character string memory table entry (string table)

Character string display element [Object] → [String]
Alarm list [Object] → [Alarm] → [List]
Alarm history [Object] → [Alarm] → [History]

� When writing to a character string memory table entry (string table)

Character string input element [Object] → [Data Input] → [String]

� When copying character strings between character string memory table entry
entries (string table)

Touch switch (copy setting) [Object] → [Touch Switch] → [Copy Set-
ting]

7-3-3 Description of Character String Memory Table (String Table) Fields

Value

Specify the initial value to be set when the power is switched ON, the PT is reset,
or the mode is changed from the System Menu to RUN.

For an initial value, a character string containing a maximum of 40 characters can
be specified. (20 characters for NT11S/NT11, 32 characters for NT20/NT20S)

To display “\”, input two characters without a blank, like “\\”.

Setting of an initial value is valid when the resume function is not selected and the
[Initial] item is selected for the character string memory table entry (string table),
and in this case the content of the character string memory table entry (string
table) is returned to the initial value. If the PT has the memory table initialization
function, this function can also be used to return the content of a character string
memory table entry (string table) to the initial value.
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By clicking the , , or  Button, you can insert
mark data, image data, or library data into a character string. (With the NT21 and
NT31/631 without NT20/30/620-compatible mode,  and

 are not enabled.)

Initial

Specify whether or not the contents of the character string memory table entry
(string table) are written to the allocated words in the host when the PT is
switched on or reset, or the mode is changed from the System Menu to RUN.

The term “initialize” means the processing to initialize the content of words in the
host with the content in a character string memory table entry (string table). The
setting for [Initial] is not valid if a character string memory table entry (string table)
is not allocated to a host word.

To make [Initial] valid, click on the check box to display a cross mark (�) in the
box. If the box is clicked on while it is in the valid state, [Initial] is made invalid.

Reference: The content of character string memory table entries (string table) at the start of
PT operation is as shown below according to whether or not a character string
memory table entry (string table) is allocated to the host, the [Initial] setting for the
character string memory table entry (string table), and whether or not the resume
function is used.

Allocation to [Initial] [Initial] settingAllocation to
Host

[Initial]
setting Used Not Used

Allocated Initialized
(valid)

Existing character string
memory table (string
table) content retained
(also for the word in the
host)

Initial value of the char-
acter string memory table
entry (string table)
(also for the word in the
host)

Content of the character string memory table entry
(string table) if it is initialized by System Menu opera-
tion
(also for the word in the host)

Not initialized
(invalid)

Content of a word in the host

Not allocated (Invalid) Existing character string
memory table (string
table) content retained

Initial value of the char-
acter string memory table
entry (string table)

Content of the character string memory table entry
(string table) if it is initialized by System Menu opera-
tion

Words
Specify the number of words in the PC (PLC) to be allocated to the character
string memory table entry (string table).

The number of allocated words varies depending on the PT model as shown be-
low.

PT Model No. of Allocated Words

NT11S/NT11 1 to 10 words (1 to 20 characters)

NT20, NT20S 1 to 16 words (1 to 32 characters)

NT30, NT30S, NT21, NT31, NT31C, NT600S,
NT620S, NT620C, NT625C, NT631, NT631C

1 to 20 words (1 to 40 characters)
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One word corresponds to 2 characters.

A character string is allocated to the PC (PLC) words in units of 2 characters, be-
ginning with the leftmost character, from lower digit words to higher digit words.
The data type is 1-byte or 2-byte.

Note If the number of characters in a character string memory table entry (string table)
is larger than the number of words used, the number of characters equal to the
number of specified words is sent to the PC (PLC) beginning with the start of the
character string.

ABCDEFG AB
If setting is 2 words.

Words allocated in PC (PLC)Character string memory table 
(String table)

If setting is 4 words.
HIJKLMN

JK

HI

CD

LM

N

* EFG is not sent.

The character string is sent in units of 2
characters, beginning with the leftmost
character in the character string, and
allocated to words from lower word to
higher word.

00 (hexadecimal) is entered in blank
areas.

PLC Address

Specify the PC (PLC) address (start address) of the area where character string
memory table entries (string table) are allocated.

I/O Comment

Specify a comment for a PC (PLC) word.
A comment can comprise up to 16 characters.

Ref

Displays whether the table entry with the specified number is already used or not.

Yes: Already used as an element.
No: Not used.

If the indication is Yes, you can check where the table entry in question is used by
clicking on . Note that this operation is not possible when setting a

character string memory table entry (string table) from the property dialog box of
an element.
(For details of , refer to 7-1-1 Reference Operation.)

7-3-4 Inserting Mark Data into a Character String
To insert mark data into an initial value, follow the steps described below.

(1) After specifying the Value field, move the cursor to the position where the
mark data is to be inserted.

(2) Click on .

The Show Mark dialog box is displayed.

(3) Specify the mark data in the list of mark data.

(4) Click on .
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The code of the specified mark data is inserted to the Value field. The mark
itself is not displayed here.

[ Insert Mark ] button [ OK ] button

Screen Screen

↑
Mark data

7-3-5 Inserting Image Data into a Character String
To insert image data into an initial value, follow the steps described below.

Note that insertion of image data into a character string is possible only with the
NT30, NT30C, NT620S, NT620C, NT625C, NT21 (NT20/30/620-compatible
mode), NT31/C-V2 (NT20/30/620-compatible mode) and NT631/C-V2
(NT20/30/620-compatible mode).

(1) After specifying the Value field, move the cursor to the position where the
image data is to be inserted.

(2) Click the  Button.

The Image Table dialog box is displayed.

(3) Specify the image data in the list of image data.

(4) Click the  Button.

The code of the specified image data is inserted into the Value field. The
image data itself is not displayed here.

[ Insert Image ] button [ OK ] button

Screen

↑
Image data

Screen

Reference: By clicking the  Button, an image code with no data can be added to the

list. You can first insert this image to a string and then register the image data
afterward. (Use the image editor to create image data.)
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7-3-6 Inserting Library Data into a Character String
To insert library data into an initial value, follow the steps described below.

Note that insertion of library data into a character string is possible only with the
NT30, NT30C, NT620S, NT620C, NT625C, NT21 (NT20/30/620-compatible
mode), NT31/C-V2 (NT20/30/620-compatible mode) and NT631/C-V2
(NT20/30/620-compatible mode).

(1) After specifying the Value field, move the cursor to the position where the
library data is to be inserted.

(2) Click the  Button.

The Library Table dialog box is displayed.

(3) Specify the library data in the list of library data.

(4) Click the  Button.

The code of the specified library data is inserted to the Value field. The library
data itself is not displayed here.

[ Insert Library ] button [ OK ] button

↑
Library data

ScreenScreen

Reference: By clicking the  Button, a library code with no data can be added to the

list. You can first insert this library code to a string and then register the library
data afterward. (Use the library editor to create library data.)

7-4 Bit Memory Table
A bit memory table is an area that operates like flags to execute preset functions
when the specified bits go ON.

A bit memory table entry provides a screen switching function that switches the
screen when the specified PC (PLC) bit goes ON and an alarm function that dis-
plays the alarm message or logs the event of alarm occurrence if the specified
PC (PLC) bit goes ON.

By allocating a bit memory table entry to a PC (PLC) bit, data can be shared be-
tween a PC (PLC) and a PT.
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Screen switching function

Screen switching

Screen No. : 2

PC (PLC) 
address : 00010

Bit memory table

   Specified PC (PLC) bitScreen 1

Screen 2

Allocated bit ON

PT

Alarm function

Character string 
memory table 
(String table) No.: 10

Image/library code: FE20

PC (PLC) address: 0001000

Bit memory table

10

11

12

13

Character string
memory table
(String table)

ABC

DEF

GHI

JKL

Image data

FE20

Specified PC (PLC) bit

ABC

Alarm list
Displayed in 
response to 
bit going ON

The range of bit memory table entries used for checking bit status is
set by the alarm list.

Displayed 
in response
to touching
a message

Specifying item 
to be called

Specifying item 
to be called

ON

Stored in alarm history

ABC 96/04/10

7-4-1 Operation Procedure
The bit memory table setting dialog box is displayed by following either of the op-
erations described below.

� At the properties of the alarm list element, click on the table entry number field.

� Select [Tools] (menu bar) → [Table], then click [Bit Memory] tab.

Setting

For bit memory table entries, the objective of the operation is specified by clicking
on a line. The necessary setting can be made by input using a keyboard or by
selection using a drop-down list.

For the operation procedure for , , ,

, and , refer to 7-1 Common Operation. (Note that
 cannot be used if bit memory table entry is displayed by the operation

using an element property.)

7-4-2 Related Elements
Alarm list element [Object] → [Alarm] → [List]
Alarm history element [Object] → [Alarm] → [History]
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7-4-3 Description of Bit Memory Table Fields

As the reference of bit memory table setting, please refer to 6-3 Alarm.

WARNING

When converting the bit memory table from NT30, NT30C,
NT620S, NT620C, NT625C to NT31, NT31C, NT631, NT631C,
the function setting is not the same with before converting. To
adjust the setting of this bit memory table, please refer to Data
Conversion (Bit memory conversion) in Appendix A.

Items set to use the screen switching function

To use the screen switching function, follow the procedure below.

(1) Input PLC address directly on a PLC address field on a bit memory table
entry or click on  and input PLC address on a PLC address dia-
log. (Refer to Word setting for an element on page 127). Input I/O comment if
required.

(2) Click on  to display function dialog.

(3) Select “Switch Screen” from function combo box.
Setting items for screen switching function are displayed.

(4) Set screen number to be switched for “Screen No..”

� Settings to make at the Set dialog

PLC Address

Specify the bit in a PC (PLC) whose status is reflected by the bit memory table
entry.

I/O Comment

Specify a comment for a PC (PLC) bit.

A comment can comprise up to 16 characters.

� Settings to make at the Function dialog

Function

Select [Alarm/Switch Screen] for NT30, NT30C, NT620S, NT620C, and
NT625C, and select [Switch Screen] for the NT21, NT31, NT31C, NT631, and
NT631C.
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Switch Screen (only for NT30, NT30C, NT620S, NT620C, and NT625C)

To make the screen switching function valid, click on the check box to display a
check mark in it. If you click on the check box when it already has a check mark in
it, the check mark is cleared and the screen switching function is made invalid.

For the NT21, NT31, NT31C, NT631, and NT631C, whether or not the screen
switching function is used is determined by the setting for [Function].

Screen No.

Specify the screen No. of the screen to which the screen switches when the bit
memory table entry goes ON.

Items set to use the alarm function

To use the alarm function, follow the procedure below.

(1) Input PLC address directly on a PLC address field on a bit memory table
entry or click on  and input PLC address on a PLC address dia-
log. (Refer to Word setting for an element on page 127). Input I/O comment if
required.

(2) Click on  to display function dialog.

(3) Select “Alarm” or “Alarm/Switch Screen” from function combo box.
Setting items for Alarm function are displayed.

(4) Make the settings for the alarm function. (See below)

� Settings to make at Set dialog

PLC Address

Specify the bit in a PC (PLC) whose status is reflected by the bit memory table
entry.

I/O Comment

� Specify a comment for a PC (PLC) bit.

A comment can comprise up to 16 characters.

� Settings to make at Function dialog

Function

Select [Alarm/Switch Screen] for NT30, NT30C, NT620S, NT620C, and
NT625C, and select [Alarm] for the NT21, NT31, NT31C, NT631, and NT631C.

Switch Screen

The meaning of the [Switch Screen] setting differs between the NT30, NT30C,
NT620S, NT620C, and NT625C and the NT21, NT31, NT31C, NT631, and
NT631C.

� NT30, NT30C, NT620S, NT620C, and NT625C

To use the alarm function, the check box must not have a check mark set in it. If
it does, the screen switching function is selected.

� NT21, NT31, NT31C, NT631, and NT631C

To display the specified screen by the operation of an alarm list/history ele-
ment, set a check mark in the check box. Clear the check mark in the check box
in order not to display the specified screen.

Screen No.

The message area displayed in the alarm list/history element is a touch switch
and pressing the touch switch that is in the selected state displays the specified
screen.
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� NT30, NT30C, NT620S, NT620C, and NT625C

Specify the screen No. of the screen to which the screen should switch by the
operation of the alarm list/history. Specify 0 if you do not switch the screen.

� NT21, NT31, NT31C, NT631, and NT631C

Specify the screen No. of the screen to be displayed if a check mark is set for
[Switch Screen]. The setting for this item is not valid unless a check mark is set
for [Switch Screen].

String Table Entry

Specify the character string memory table entry (string table) number where the
character string that is displayed as a message is stored when the bit memory
table entry goes ON or the bit memory table entry registered for the alarm history
is displayed.

Image/Library Code

If you want to display image data or library data when a message is selected, set
a check mark in the check box and specify the image/library code after clicking on

 or .

Color – Foreground

Specify the color in which the message display field is displayed when a mes-
sage is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

� Code setting in the image/library code field

When setting a code in the image/library code field, the desired code can be
selected from the list as an alternative to direct input of a specified code using a
keyboard.

Setting the image data

To set an image code in the image/library code field by selecting image data
from the list, follow the procedure described below.

(1) Specify the image/library code field where the code is set.

(2) Click on .

(3) Specify the image data from the list.

(4) Click on .

The code of the specified image data is displayed in the image/library code
field.

[Insert Image]
button

[OK] button

Setting the library data

To set a library code in the image/library code field by selecting library data from
the list, follow the procedure described below.
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(1) Specify the image/library code field where the code is set.

(2) Click on .

(3) Specify the library data from the list.

(4) Click on .

The code of the specified library data is displayed in the image/library code
field.

[Insert Library]
button

[OK] button

7-5 Extended I/O Input Table
The extended I/O input table is used to set functions at the input terminals of an
extended I/O unit or allocate PC (PLC) bits to be referred to.

Extended I/O units can be used only with NT30 and NT30C.

The following functions can be set at extended I/O unit input terminals.

Screen switching

Screen 1

Screen 2

PT

External input

Extended I/O input table

Screen switching
2Screen No.

When the input terminal goes ON, the screen is switched to the set screen.
If 0 is set, the display returns to the previous screen.

Notify bit

Notify bit
PC (PLC) 
address:

0000002

PT

External input

PC (PLC)

Extended I/O input table

The extended I/O input table notifies the PC (PLC) of the status (ON/OFF) of the
input terminals.
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Control code input

Control code 
input function
Control key RET

PT

External input

Extended I/O input table

Data input field
1234

When the input terminal goes ON, it has the same effect as pressing of the control
key.

Canceling backlight OFF

Canceling backlight 
OFF function

External inpu�

Extended I/O input table

Backlight 
ON

Backlight 
OFF

PT

When the input terminal goes ON, the backlight, which has been turned OFF by
the Cancel Backlight Off function set by a memory switch, is turned ON to redis-
play the screen. A backlight OFF function releasing attribute is automatically pro-
vided for the screen switching function and the control code input function.

Do not use the input function of a PT extended I/O input

for applications that could cause fatal injury and/or

serious damage, or as an emergency switch function.

7-5-1 Operation Procedure

An extended I/O input table entry is displayed by following the operation de-
scribed below.

� Select [Tools] (menu bar) → [Table] → [Extended I/O Input] tab → Clicking on
table entry No. → 

Setting

Settings for the extended I/O input table fields can be made by using the setting
dialog box that is displayed by clicking on .

For the operation procedure for , , and ,
refer to 7-1 Common Operation.

WARNING
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7-5-2 Description of Extended I/O Input Table Fields

No.: Extended I/O unit input terminal number.

Cncl: Presence/absence of the backlight OFF cancelling attribute.
Make this setting at Set dialog.

Function: Function set for the input terminal.
Notify bit, Switch Screen, Input Key-Control.
Make this setting at Set dialog.

Description: Contents set at “Function” are shown.
Make this setting at Set dialog.

Cancel Backlight Off

Specify whether or not the backlight OFF state is to be canceled.

To set the Cancel Backlight Off function, click on the check box to set a check
mark in it.

If you do not want to set the Cancel Backlight Off function, clear the check mark in
the check box.

This setting is valid when [None] or [Notify Bit] is set for [Function].

The Cancel Backlight OFF function is automatically provided for the screen
switching function and the control code input function.

Function

Specify the input terminal function.

� None

� Switch Screen

� Notify Bit

� Input Key – Control

When Switch Screen is specified

Screen No.

Specify the screen No. of the screen to which the screen should be switched
when the input terminal goes ON.
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When Notify Bit is specified

Notify Bit Address

Specify the PC (PLC) bit where the event of the input terminal going ON is noti-
fied.

Comments

Specify a comment for a PC (PLC) bit.
A comment can comprise up to 16 characters.

When Input Key – Control is specified

Control Key

Select the control code to be input when the input terminal goes ON from the list.

: Inputs numeral 0 in a data input field.

: Inputs numeral 1 in a data input field.

: Inputs numeral 2 in a data input field.

: Inputs numeral 3 in a data input field.

: Inputs numeral 4 in a data input field.

: Inputs numeral 5 in a data input field.

: Inputs numeral 6 in a data input field.

: Inputs numeral 7 in a data input field.

: Inputs numeral 8 in a data input field.

: Inputs numeral 9 in a data input field.

: Inputs hexadecimal A in a data input field.

: Inputs hexadecimal B in a data input field.

: Inputs hexadecimal C in a data input field.
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: Inputs hexadecimal D in a data input field.

: Inputs hexadecimal E in a data input field.

: Inputs hexadecimal F in a data input field.

: Deletes numeric value/character string in a data input field.

: Confirms inputs in a data input field (cursor remains in this field.).

: Toggles plus (+) and minus (−) sign in a data input field.

: Inputs a decimal point in a data input field.

: Moves the input cursor to the data input field at the upper left area.

: Moves the cursor to the data input field immediately above the present
data input field.

: Moves the cursor to the data input field immediately below the present
data input field.

: Move the cursor to the left data input field.

: Move the cursor to the right data input field.

: Moves the cursor to the previous data input field in the order.
Changes the continuous screens to the previous screen.

: Moves the cursor to the next data input field in the order.
Changes the continuous screens to the next screen.

: Stops Buzzer.

: Displays the System menu.

After setting the items for the selected function (switch screen, notify bit, control
code input), click on .

The specified contents are displayed in the extended I/O input table entry.

7-6 Extended I/O Output Table
An extended I/O output table controls the output terminal of an extended I/O unit
according the ON/OFF status of a PC (PLC) bit.

Extended I/O units can be used only with NT30 and NT30C.

PC (PLC) address:
0001002

PT

External output

PC (PLC)

Extended I/O output table
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7-6-1 Operation Procedure

An extended I/O output table entry is displayed by following the operation de-
scribed below.

� Select [Tools] (menu bar) → [Table] → [Extended I/O Output] tab

Setting

With an extended I/O output table entry, the objective of an operation is specified
by clicking on the line. Setting is performed by using the setting dialog box that is
displayed by clicking on .

For the operation procedure for , , and ,
refer to 7-1 Common Operation.

7-6-2 Description of Extended I/O Output Table Fields

No.

Extended I/O unit output terminal number.

PLC Address

Specify the PC (PLC) bit that controls the output terminal of an extended I/O unit.

I/O Comment

Specify a comment for a PC (PLC) bit.
A comment can comprise up to 16 characters.

7-7 I/O Comment Table
The I/O comment table is an area provided in a PT to manage the comment data
of all words and bits in a PC (PLC) that are set by the Support Tool.

It displays comments on PC (PLC) words and bits specified by numeral memory
table entries, character string memory table entries (string table), bit memory

tschmitt
Textfeld
7-6 Extended I/O Output Table
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table entries, extended I/O input table entries, extended I/O output table entries,
and elements, in the form of list. The displayed comments can be edited.

Reference: If “--” is displayed for PLC Bit Address when its “Ref” is Yes, object without PLC
address exist.

Clicking on enables to know which objects is created without PLC ad-

dress.

7-7-1 Operation Procedure
An I/O comment table entry is displayed by following the operation described be-
low.

� When allocating PC (PLC) address by the setting of lamps and touch switches

Click on  in the I/O comment field of the properties displayed for each ele-

ment → Specify the edit field → Click on 

Example:

Click

�  [Tools] (menu bar) → [Table] → [I/O Comments] tab → Specify the edit field →

Reference: � When only editing an I/O comment of a PC (PLC) address allocated to an ele-
ment, call out the I/O comment table entry from the property dialog box of the
element.

� To set an I/O comment for multiple PC (PLC) addresses, select the [Tools]
menu, then select [Table].

Setting

To edit an address or a comment, display the setting dialog box by clicking on
or edit directly on a table entry.

For the operation procedure for , , and , refer to

7-1 Common Operation. (Note that  cannot be used if it is displayed by

the operation using an element property.)
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7-7-2 Description of I/O Comment Table Fields

Displaying specified word and bit I/O comment

Editing and adding I/O comment

Displaying I/O comment for specified word and bit

The items displayed on an I/O comment table are shown below.

Address

Displays the PC (PLC) word or bit address that corresponds to the comment.

I/O Comments

Displays the comment for the PC (PLC) word or bit.

Reference

Displays if the word is already used or not.

Yes: Already used in an element or a table.
No: Not used.

If the indication is Yes, you can check where the word in question is used by click-
ing on .

(For details of the  button, refer to 7-1-1 Reference Operation.)

For details of the  button, refer to 7-1-2 Search Operation.

Editing or adding an I/O comment

� Editing (modifying) an I/O comment

To edit (modify) the I/O comment already set, click on the table entry number,
then click or edit directly on a table entry.
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� Adding an I/O comment

To set (add) an I/O comment, after clicking on the table entry number of the
blank field at the bottom, click .

� Setting items in the set dialog box

Channel (Word)

Specify the type of area (area name in PC (PLC)) for which a comment is to be
displayed.

Address

Specify the address number where the I/O comment to be edited is allocated. If
you specify a new address or bit, an I/O comment can be added.

If a comment is allocated using an element or a table entry (i.e., Yes is dis-
played for [Reference]), it is not possible to change the comment.

It is possible to change the comment if it is not allocated using an element or a
table entry.

Bit

Specify the PC (PLC) bit number where the I/O comment to be edited is allo-
cated. If you specify a new address or bit, an I/O comment can be added.

If a comment is allocated using an element or a table entry (i.e., Yes is dis-
played for [Reference]), it is not possible to change the comment.

It is possible to change the comment if it is not allocated using an element or a
table entry.

I/O Comments

Specify a comment for a PC (PLC) address or bit.
A comment can comprise up to 16 characters.

7-7-3 Importing I/O Comments from a Ladder Program
With NT-series Support Tool for Windows, it is possible to import I/O comments
from the ladder program that is created using the following PLC Support Soft-
ware. Inputting I/O comments can save time and labor.

This section describes the import method of I/O comment.

� SYSMAC Support Software, SYSMAC CPT

I/O comments can be imported from a C-series ladder program with the exten-
sion .SP1.

Reference: � With SYSMAC Support Soft, when saving ladder program, I/O comments are
automatically saved in a file with an extension .SP1.
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SYSMAC CPT saves ladder program in SSS program (*.SP1) and use this file
to import I/O comment.

� I/O comment of CVM1/CV series can not be imported with Support Tool.

� With SYSMAC CPT, it is not possible to save ladder program of PLC with “-Z” in
a file with an extension .SP1. Therefore, Support Tool can not import I/O com-
ment of ladder program for “-Z” created with SYSMAC CPT.

Priority in I/O comment

When the I/O comment table at Support Tool has an existing I/O comment or
when both word I/O comment and its bit I/O comment exist in ladder program to
be imported (e.g., 0005CH:DDD, 000512:EEE), priority will be as follows
(smaller number takes higher priority):

(1) Existing I/O comment in Support Tool (in I/O comment table)

(2) I/O comment of bit in ladder program to be imported

(3) I/O comment of word in ladder program to be imported

Example: Existing I/O comments in Support Tool (in I/O comment table)

Word / Bit I/O Comment

0005 AAA

000603 BBB

0007 CCC

I/O comments in ladder program to be imported

Word / Bit I/O Comment

0005 DDD

000512 EEE

0006 FFF

000613 GGG

000708 HHH

0008 III

↓

I/O comments in Support Tool (in I/O comment table) after importing

*: Existing I/O comment in Support Tool (in I/O comment table)
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Handling of I/O comments of Timer / Counter

Timer/Counter do not have their own number. They share common Timer/Count-
er number.

However, with an I/O comment table at Support Tool, it is possible to input Timer
and Counter separately.

So when the Timer/Counter number is imported, I/O comment table stores the
same comment both for timer and counter of the same number.

In case I/O comment table at Support Tool has an existing I/O comment for either
of timer and counter, existing I/O comment in Support Tool (in I/O comment table)
takes priority and imported I/O comment will be stored only for an empty one.

Example: Existing I/O comment in Support Tool (in I/O comment table)

Word / Bit I/O Comment

TIM002 AAA

CNT002 BBB

CNT003 CCC

I/O comments in ladder program to be imported

Word / Bit I/O Comment

TIM/CNT000 DDD

TIM/CNT002 EEE

TIM/CNT003 FFF

TIM/CNT004 GGG

↓

Existing I/O comments in Support Tool (in I/O comment table) after importing

*: Existing I/O comment in Support Tool (in I/O comment table)

Import Procedure

SYSMAC Support Software, SYSMAC CPT

Follow the procedure below to import I/O comment from ladder program.

(1) Select “Import I/O Comments” from the Tools menu.
Dialog box to specify I/O comment is displayed.

(2) Specify the I/O comment file (.SP1) to be imported and click the 
Button.
I/O comment Import is performed. While importing, progress will be dis-
played on status bar.



7-7SectionI/O Comment Table

302

(3) When the operation is finished, the message “Import of I/O Comments, op-
eration completed” is displayed. Then, click the  Button.
When an I/O comment import was aborted or could not be done because of
error, the message “Failed to import I/O comment” is displayed, then click
the  Button. In this case, the contents of I/O comment table in
Support Tool remain unchanged.
If this message box is displayed, check the following points.

� Is this a program file for OMRON C-series PLC?

� Is the extension .SP1 (SSS program file format)?

In case OMRON SYSMAC CPT is used, store (export) the ladder program in
SSS program (*.SP1) format and then use this file to import I/O comment.

Reference: � For SYSMAC Support Soft, SYSMAC CPT, priority of word types to be im-
ported is given below. CIO has the highest priority.
(With comments of more than 3000 entries, D will be cut first.)

CIO (Bit)
L (Bit)
H (Bit)
TIM/CNT
A (Bit)
CIO (Word)
L (Word)
H (Word)
A (Word)
D (Word)

The I/O comments table displays comments in numerical/alphabetical order.

Using CX-Programmer

Use the following procedure to import the I/O comments from the CX-Program-
mer.

(1) Copy the symbol table in the CX-Programmer and paste it into Excel.

(2) In Excel, delete columns 2 and 5 to that the names, addresses, and com-
ments are lined up across the sheet.

Delete columns 2 and 5.
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(3) Select Save as and save the sheet as tab-delimited text.

(4) Select Import I/O Comments from the Tool Menu in the Support Tool and
select the file saved in step 3. The comments will be imported.

7-7-4 Importing I/O Comment from Tab-delimited Text File
Import Procedure

(1) Select “Import I/O Comments” from the Tools menu.
The dialog box to specify I/O comments will be displayed.

(2) Specify “CX-P IO Comments (Tab Delimited) (*.txt)” or “All Files” as a file
type and specify the I/O comment file (tab delimited text file) saved and click
the [OK] Button.
The I/O comment will be imported.

(3) When the operation is finished, the message “Import of I/O Comments, op-

eration completed” will be displayed. Next, click the  Button.
When an I/O comment import was aborted or could not be performed be-
cause of an error, the message “Failed to import I/O comment” will be dis-

played. Click the  Button to clear the message. In this case, the
contents of the I/O comment table in Support Tool remain unchanged.
If this message box is displayed, check the following points.

� Is the data format of the I/O comment file to be imported (tab delimited text file)
correct? (see the following page)

If an import is aborted in the middle of the import operation, I/O comments in the
Support Tool will remain unchanged.

Text file format to be imported by the Support Tool

The Support Tool can read the tab-delimited text file, which was created by the
user, as an I/O comment file. Here, the rule for the text file format is described.

Format

� One line must be constructed as follows:

Name [TAB] PLC address [TAB] I/O comment [Enter]

Example

START 0.01 START(ON)

STOP 0.02 STOP(OFF)

N_DataV1082 DM1082 Speed1

N_DataA1083 DM1083 Speed2

For details of the format rule, see the description below and the [Example of im-
port].

Name

The Support Tool imports only the PLC address and the I/O comments to the I/O
comment table. Therefore, the address name can be omitted.

In this case, however, be sure to insert TAB code before “PLC address.”

Example

[TAB]0.01[TAB]START(ON) [Enter]
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PLC address

Each word type should be expressed as shown below. To specify a bit number,
input bit number after a decimal point.

Word Prefix
Example

Word Prefix
C series CS/CJ series

CIO area Address (None) 120 120

Bit 0.12 0.12

HR area Address HR or H HR120 H120

Bit HR0.12 H0.12

AR area Address AR or A AR120 A120

Bit AR0.12 A0.12

LR area Address LR LR120 L120 *

Bit LR0.12 L0.12 *

Timer TIM or T TIM100 T100

Time up flag TU --- TU100

Counter CNT or C CNT100 C100

Count up flag CU --- CU100

Work area Address W --- W120

Bit --- W0.12

Task flag TK --- TK1

Data memory area DM o r D DM20 D20

EM current bank EM or E EM20 E20

EM bank specification 
(�: Bank specification, hexade-
cimal, 1 digit)

E�_ --- EC_20

*: CS/CJ series does not have an LR area. If an LR area bit (L00000 to L00199) is
set to screen data, it will be automatically converted to CIO 01000 to CIO 01199
inside the PT.

I/O comment

If an I/O comment longer than 16 characters is set, the remaining characters are
discarded.

Example of import

Strings Import Result
Strings Import

OK/NG PLC address I/O comment

ABC [Enter] NG --- ---

�ABC [Enter] NG --- ---

�ABC�� [Enter] NG --- ---

ABC [TAB] 100.01 [TAB] comment1 [Enter] OK 0010001 comment1

ABC [TAB]100.02 [TAB] [Enter] OK 0010002

ABC [TAB] [TAB] comment2 [Enter] NG --- ---

ABC [TAB] [Enter ] NG --- ---

ABC [TAB] [TAB] [Enter] NG --- ---

ABC [TAB] �� [TAB] �� [Enter] NG --- ---

�� [TAB] �� [TAB] �� [Enter] NG --- ---
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[Enter] Ignored --- ---

[TAB] [TAB] [Enter] NG --- ---

[TAB] [Enter] Ignored --- ---

� [TAB] 100.03 [TAB] comment3 [Enter]r OK 0010003 comment3

� [TAB] 100.04 [TAB] [Enter] OK 0010004

� [TAB] 100.05 [Enter] NG --- ---

[TAB] [TAB] comment4 [Enter] NG --- ---

[TAB] [TAB] [TAB] [EOF] NG --- ---

[TAB] 100.06 [TAB] comment5 [EOF] OK 0010006 comment5

ABC [TAB] 100.07 [TAB] comment6 [EOF] OK 0010007 comment6

�: Blank space [TAB]: TAB code
[Enter]: Enter code [EOF]: End of file

Reference: � It may take time to import I/O comments when there are many I/O comments.

� There are the PLC address, I/O Comment, and Reference in an I/O comments
table. Addresses with no comment and no reference will not be downloaded to
PT. (See below)

Referenced Not Referenced

With Comments � �

Without Comments � ×

�: Can be downloaded  ×: Cannot be downloaded

Lines in an I/O comment table with only the PLC address input (for future use
etc.) will not be downloaded to PT, and as a result, when the data is uploaded to
the Support Tool, the line itself will be lost. (This also applies when saving data
in mmi format.)

� Support Tool cannot import more than 3,000 PLC addresses with comments.
Therefore, if there are more than 3,000 PLC addresses with comments, only
the addresses will be imported for PLC addresses from entry 3001 onwards.
(I/O comment import operation will be finished normally.)
Rejected entries are displayed in the Error Log. Check them by selecting [Error
Log] from the [View] menu and print them.

7-8 F-Key Input Notify Table
This table is only available for NT11S/NT11. The F-Key Input Notify Table con-
sists of four entries. Each entry is assigned to a function key in the PT device. It
specifies a PC (PLC) memory bit to be related to a corresponding function key.

7-8-1 Operation Procedure

An F-Key Input Notify Table is displayed by following the operation described be-
low.

� Select [Tools] (menu bar) → [Table] → [F-Key Input Notify] tab → Specify the
edit field → 
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7-8-2 Description of F-Key Input Notify Table

Table Entry Number

The table entry number field, or the <No.> column is not editable. All table entries
are listed in ascending order of their entry numbers, starting from zero to one less
than the maximum number of entries.

Table Entry No. F-Key Input

0 F1

1 F2

2 F3

3 F4

PLC Bit Address

Specify the PC (PLC) bit that you want to link with the Function Key.

I/O Comment

Specify a comment for a PC (PLC) address or bit.

A comment can comprise up to 16 characters.

7-9 Mathematical Table
Mathematical table is only available for the NT21, NT31/631-V2 and above. The
table may contain 0 to 255 entries and each entry can be assigned a mathemati-
cal formula. The result of each calculation can be stored in either a Numeral
Table entry or a PLC address.

7-9-1 Operation Procedure
The mathematical table setting dialog box is displayed by following either of the
operations described below.

� Select [Tools] (menu bar) –> [Mathematical Table].

� Double click on “Mathematical Table” from application manager window

7-9-2 Supported Objects
The following objects are affected or have an effect on the Mathematical Table:
Numeral Display, Numeral Input, Thumb wheel switch, Bar Graph, Analogue me-
ter, Broken Line Graph, Trend Graph.
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7-9-3 Supported PLC Addresses
The supported addresses for the operand and result based on the PLC vendor
type are as follows:

Omron

Word Range

CIO 00000 to 32767 (decimal)

DM 00000 to 32767 (decimal)

HR 00000 to 32767 (decimal)

AR 00000 to 32767 (decimal)

LR 00000 to 32767 (decimal)

EM 00000 to 32767 (decimal)

WR 00000 to 32767 (decimal)

E0 to EA 00000 to 32767 (decimal)

C 00000 to 32767 (decimal)

T 00000 to 32767 (decimal)

Memory Link

Word Range

CIO 00000 to 32767 (decimal)

Mitsubishi A

Word Range

X 0000 to 2700 (hexadecimal)

Y 0000 to 2700 (hexadecimal)

M 0000 to 9984 (decimal)

L 0000 to 9984 (decimal)

B 0000 to 2700 (hexadecimal)

D 0000 to 9999 (decimal)

R 0000 to 9999 (decimal)

W 0000 to 270F (hexadecimal)

C 0000 to 9999 (decimal)

T 0000 to 9999 (decimal)

Mitsubishi Fx

Word Range

X 00000 to 23400 (octal)

Y 00000 to 23400 (octal)

M 0000 to 9984 (decimal)

S 0000 to 9984 (decimal)

D 0000 to 9999 (decimal)

C 0000 to 9999 (decimal)

T 0000 to 9999 (decimal)
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7-9-4 Description of Mathematical Table Fields

Description

The mathematical function specified in each table entry will be displayed here in
the form of a simple equation. Left-hand side of the equation will indicate the
location where result calculated from the function will be stored. Right-hand side
will display the actual function.

Set

Invokes ‘Set Mathematical Dialog Box’. Specify mathematical function using this
dialog box.

Edit

Refer to 7-1 Common Operation.

Goto Entry

Refer to 7-1 Common Operation.

Move

Invokes ‘Move To’ dialog box. Move a table entry using this dialog box

Close

Closes the dialog box.

Help

Shows help information related to mathematical table.
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7-9-5 Description of Set Mathematical Formula Fields
This dialog box is to be used to define a new/edit an existing mathematical formu-
la.

Formula

Shows the list of available formula that can either be arithmetic, boolean or bit-
wise operations. This will list out combinations of available operands and opera-
tors i.e., type of the function.

Selected Formula

Shows the selected mathematical formula for this entry. It is updated whenever
there is any change in operands or operators.

Word Size

This is a common setting for Result and Operand. It is only valid for PLC Address
and constant. For Numeral Table entry, the word size will follow the setting in the
Numeral Table. This control will be enabled when the selected formula is not
‘None’.

Result

This button will be used to specify the result. This button will be enabled when the
selected formula is not ‘None’. The following choices are available for result loca-
tion.

� PLC word address

� Numeral table entry

Operand buttons

This buttons will be used to specify operands. Operand buttons will be enabled
according selection of [Formula]. The following choices are available for oper-
ands.

� Constant value (integer only)

� Numeral table entry (Direct)

� PLC Address

 Operators

These combo boxes will provide a list of available operators. Operator combo
boxes will be enabled according selection of [Formula]. Following choices of
types of operators will be available.
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7-10-3 Record Setting Table

This Record Setting Table dialog box permits you to specify the settings for all
records of a recipe entry in the recipe table.

Description of Record Setting Table Controls

Start Address

Displays the starting PLC address.

No.

Displays the record number.

Record

Specifies the name for the record entry.

A string of up to 12 characters can be used and edited.

Parameter Title

Displays the parameter name, i.e., “Param1” and “Param2.” Default value is “Pa-
ramX,” where X is a number.

Up to 8 characters can be used and edited, with the column width depending on
the parameter values.

Parameter

Displays the numerical data values for each record.

You can edit data values. The Initial value is 0.

Lock

Sets the Record as read only.

Edit Param

Displays the parameter setting table.
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Edit

Permits clear, copy and paste operations on a selected range of record entries.
An edit popup menu with these 4 options will appear, like the menu in the current
numeral table entry.

Clear, Copy, Paste is only enabled when the clipboard contains record data.

Goto Entry

Allows the selection of an entry by specifying the entry number through a Go to
dialog. The behavior is same as the numeral table Go to dialog.

Insert Mark

Inserts a mark object in a record or a parameter name.

Import

Import parameter data from a CSV formatted file. A file open dialog with a CSV
Formatted Recipe Data (*.csv) filter will prompt for the source file.

Export

Export all data of this recipe entry. A file save dialog with a CSV Formatted Rec-
ipe Data (*.csv) filter will prompt for the target file name. Exporting a selection of
parameter data is not supported.

Reset Width

Resets the width of each column to the default setting.

Note The parameter data cell will always be displayed using the parameter’s number
format. A decimal type parameter will display values in decimal, while a hexade-
cimal type parameter will display values in hexadecimal.

Parameter Setting Table

This dialog permits users to specify the setting for all parameters of a recipe table
entry.

When the Words field is changed from 2 to 1, you will be prompted with a mes-
sage that some data will be lost with this conversion. If the value is less than
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–32,768 or greater than 32,767, the value will be set to 0. Otherwise, if the sum of
Integer and Decimal digits exceed the maximum limit, the number of Decimal
digits will be reduced. For example, given a parameter with settings “Dec,” “4 In-
teger” and “4 Decimal” and value 54.3675, when word size is reduced to 1, set-
ting will become “4 Integer” and “1 Decimal” and value will be 54.3.

When entering values into the Integer and Decimal fields, the following validation
will occur. When “Dec/Hex” is decimal and “Integer” or “Decimal” is set so that
their sum is greater than the maximum digits allowed, once the cell loses the fo-
cus, the following occurs:
a) If the entered value is less than or equal to the maximum digits allowed, it is
accepted. Any other value is reduced, so that their sum is not greater than the
maximum digits allowed.
b) Otherwise, the entered value is set to the maximum digits allowed and the oth-
er value is set to 0.
The maximum digits allowed is 5 (1 word) or 10 (2 words).

Description of Parameter Setting Table Controls

No.

Displays the parameter entry number.

Parameter

Displays the parameter name.

A string of up to 8 characters can be used and edited.

Dec/Hex

Displays the numeral display format, either decimal or hexadecimal.

When this is changed Integer and Decimal will be reset to default.

Sign

Display sign option. Check if you want a sign to be displayed.

Integer/Decimal

Displays the precision of the integer/decimal digit of the numeral data. Limitation
on the sum of integer and decimal digits will follow the numeral display restriction.

Words

Defines the memory size for the parameter. The address column will be reset
when this size is changed.

PLC Address

Displays the starting PLC address used by the parameter.

Goto Entry

This will allow the selection of an entry by specifying the entry number through a
Go to dialog.

Insert Mark

Inserts a mark object in a parameter name.

Import

The Parameter values in the records of a recipe can be edited through a CSV
(Comma Separated Values) file. Each line consists of the fields of a record, with a
comma separating two fields.
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The first line of a CSV file is the header. The first field is the recipe name. If it con-
tains ASCII characters from 0x00 to 0x1F will be converted to spaces after im-
port. The second field is “Master Record Flag,” which is equivalent to the Lock
check box in the Record Setting dialog. Subsequent fields are the names of all
the parameters in the record.

The second line onwards contain the parameter value of the records in the rec-
ipe. The first field is the record name. The second field is a value indicating
whether the Lock check box should be checked or unchecked. 0 means un-
checked and 1 means checked. Any other values are considered invalid. Subse-
quent fields are the actual values of the parameters in that record.

During export of parameters in the Record Setting Table, the decimal points of
the parameters will not be exported. Example: Parameter 1 is set to 3 integer
digits and 2 decimal digits, and the parameter value is 123.45. After exporting to
CSV format the value will become 12345. Hexadecimal values will be converted
to the decimal equivalent after export.

If you try to import a CSV file that has a value with a decimal point, it is considered
invalid and an improper line dialog is displayed. Likewise, hexadecimal values
containing A-F are not allowed.

Improper Line Dialog

The import operation will overwrite all the current parameter values. However, if
any line in the file is incorrect, an improper line dialog will prompt for instructions.
An improper line is any line of text in the source import file whose data does not
comply with the CSV format or whose data is not valid. Any incorrect value in a
CSV line is shown in red in the Original row as shown in the diagram below. The
Import row will display the adjusted values. You can change the values high-
lighted in red to the desired ones.

In the Name field, if the string consist of more than the allowed number of charac-
ters, the data will be truncated from the right.

In the Lock field, ’0’ means unchecked and ’1’ means checked. Anything other
than that is considered invalid. This value will be reset to uncheck.

In the Parameter fields, any non-numeric data is considered invalid. The values
will be reset to 0.
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Example

For example, if the imported data is “this is only for testing” and only 11 characters
are allowed, then the grid cell will show “this is only” in red. “for testing” will be
truncated.

“**12**” is not valid for the Lock field and is thus highlighted in red.

So are “$%#@” and “$62#!78” for parameter values, which are both reset to 0.

Description of Improper Line Dialog Controls

Improper Line

You cannot edit this [Improper Line] edit box.

Displays the improper line in the CSV file.

Detail

Original – Shows the original CSV line. It cannot be edited and these invalid val-
ues will be displayed in red.

Import – Shows the default values and you can modify the default values.

Name

Shows the first value in the CSV file. This is the record name. If the value has
more than 12 characters, only the first 12 characters from the left will be shown.

Accepts a character string of up to 8 characters.

Lock

Shows the second value in the CSV file. This is the master record flag. Only the
first character from the right of the value is shown.

Can only accept 0 or 1 (0: unchecked, 1: checked).

Parameter data

Show the other values in the CSV file. These are the parameter data values. If the
imported value has more than the number of characters allowed, the value will be
set to 0.

Ignore

Ignore this improper line and proceed to import the rest of the lines in the file.

Ignore All

Ignore all improper lines and proceed to import the rest of the lines in the file.
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When more than one image editor window is displayed or when two Support
Tools are opened by [Import Component] from the [File] menu (same PT model
setting), cut, copy and paste operations between these image editor windows
are possible. For details, refer to 3-3-6 Importing Components from Different
Screen Data File (Starting Up the Second Support Tool).

Saving to the bit map file

You can save the created graphic to the file in bit map format.
This operation is valid for the graphics in the range specifying frame.

To save the graphic to the bit map file, follow the procedure below.

(1) Specify the area to be saved in a file with a range specifying frame.

(2) Select [Copy To] from the [Edit] menu.
The dialog box to specify the file name is displayed.

(3) Set the folder and file name and click the  Button.

Graphics in the range specifying frame is saved in a file.

Pasting from the bit map file

You can read out the graphics saved in a bit map file and paste them onto the
image editor.
The graphics can be pasted onto the image editor that is currently activated.

To paste the graphic from the bit map file, follow the procedure below.

(1) Select [Paste From] from the [Edit] menu.
The dialog box to specify the file to be read is displayed.

(2) Specify the folder and file name and click the  Button.

Read out graphic is pasted onto the image editor enclosed with a range
specifying frame.

(3) Select [Clip] from the [Edit] menu.
Image data size is changed to the read out image size.

Instead of the procedure (3), it is also possible to drag the read out image to the
required position.
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Changing the image data size

The image data size can be changed in either of the following two ways.

� Changing the size by property setting

� Changing the size to the range specifying frame size

� Changing the size by property setting

Change the setting for [Size] in the image editor property settings to change the
size of the image data.

The image data size is changed according to the new setting; the reference
point of the size change is at the upper left corner of the present size.

If the size is reduced, part of the created graphic may be cut.

� Changing the size to the range specifying frame size

The size of the image data can be changed to fit the size of the specified range
specifying frame.

Select [Edit] in the menu bar, then select [Clip].

Quitting the image editor

You can quit the image editor in any of the three ways described below.

� Clicking the  Button at the upper right corner of the image editor.

� Selecting [Close] from the control menu box of the image editor.

� Double clicking the control menu box of the image editor.

Control menu box
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8-2 Library Editor
Graphics of any required shape can be created by combining fixed elements.
The created graphic can be registered as one element (library data) and any
number of elements can be displayed at any positions in any screen using the
library display function.

Created library data can be used for image/library lamp display, alarm list display,
alarm history display.

Reference: Library editor has the following features.
� You can draw any graphics by combining fixed elements.
� It is possible to import library data from the different screen data file.
� Fixed display elements can be copied, cut, pasted from the editing screen 
� Copy, cut, paste operation of library data is possible.
� Preview display of selected library data is available on the library table.

8-2-1 Operating the Library Table
Library table dialog is configured as follows:

[Edit] Deletes, cuts, copies or pastes the library data of the selected. . . . . . . . 
code (refer to pages 335 to 336). It is possible to select two or
more codes and delete them collectively.

[Goto Code] Code number can be specified and the cursor moves to the. . 
code. The operation method is same as the “Goto Entry” of
memory table (refer to 7-1-6 Table Display Operation by Spec-
ifying the Table Entry Number).

[Preview] Switches the preview window ON and OFF (refer to page. . . . . 
335).

[Open] Displays the editing screen (library editor) of the selected. . . . . . . 
code (P343). When two or more codes are selected, edit
screens of all the selected codes can be opened collectively.

[New] Registers the new library code to the library table (refer to. . . . . . . . 
page 337).
Only the registered library codes are listed on the library table.
Press this button when you are going to create new library
data.

[Delete] Deletes the library data of the selected code. When two or. . . . . . 
more codes are selected, they can be deleted collectively.

[Close] Closes the library table dialog.. . . . . . . 
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[Help] Displays Help about the library table dialog box.. . . . . . . . 

� Specifying a code

To specify a code for operations, click on the objective line (library code).
To specify the continuous codes collectively, click on the first code to be se-
lected and then the last code to be selected while pressing the Shift key.
If you click on a code while pressing the Ctrl key, the code will be selected or
deselected alternately each time it is clicked.

� Preview Function

Support Tool provides a preview function that can display the contents of the se-
lected code.
When two or more codes are selected, the preview of the code selected last will
be displayed in preview window. 
The preview window can be switched ON and OFF using the /

 Buttons.

� Deleting the library data

To delete a library data, follow the procedure below. Deleted library data will not
be stored to the clipboard and its code itself will be also deleted. When two or
more codes are selected, they will be deleted collectively.

(1) Select [Library Editor] from the [Tools] menu.
The library table is displayed.

(2) Select the code of the library data to be deleted.
 When two or more codes are selected, they can be deleted collectively.

(3) Perform one of the following operations.
�  button → [Delete]
� Right click on the selected code → [Delete]
�  button
Selected code will be deleted after you click the  Button in the con-
firmation dialog box.

� Cutting/copying the library data

To cut or copy a library data, follow the procedure below. The cut/copied library
data will be stored to the clipboard and can be pasted to the other codes.
In case of “cut,” cut code will be deleted from the library table. In case of “copy,”
copied code remains in the library table.




